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Welcome to the MetaTrader and MetaEditor User Manual 
In this user manual, you’ll find instructions on how to use the features and tools in MetaTrader. If you’re new to the 
program, you can walk step-by-step through this manual to learn how to login and access specific MetaTrader features. If 
you’ve been using automated trading systems for a while, we’ve included a detailed table of contents so you can quickly 
reference how to use a specific section or tool in the MetaTrader platform. 

What are MetaTrader and MetaEditor? 
MetaTrader is an online trading system that allows you to place trades, manage open positions and pending orders, and 
conduct technical analysis. You can also use MetaTrader with automatic trading and analysis tools. Once these tools are 
active in the chart window, MetaTrader automatically executes and manages orders based on market conditions and the 
settings you specified. This user manual provides a comprehensive look at all of the tools and features in MetaTrader. 

This manual also provides an overview of MetaEditor, an application installed with MetaTrader that develops autotrading 
tools. With MetaEditor, traders can import, create and modify expert advisors, custom indicators, scripts and other 
MetaTrader autotrading tools.  

Before You Use MetaTrader and MetaEditor 
You should have a basic understanding of the forex market. If you are new to trading currency pairs, GFT offers a variety of 
free resources to help you learn about the market and how you can reach your personal trading goals. Visit GFT’s website 
to find out more. 

MetaEditor is a development tool. If you plan on creating and editing autotrading files, you should be familiar with the 
MQ4 programming language. You can learn more about this at: http://www.mql4.com.  

Even if you aren’t familiar with programming, you can use the application to download autotrading files.   

Tips for Using This Manual 
GFT uses the following notes to emphasize important information about MetaTrader. 

 
Describes information on the action of a tool or feature in MetaTrader. When you see this symbol, it provides a 
larger context for information and procedures. 

 
Provides hints, tricks and shortcuts that may help you as you place and monitor trades in MetaTrader. 

 
Alerts you of critical information that you need to know when you perform a particular procedure. 

 

http://www.mql4.com/�
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Section 1: Opening MetaTrader for the First Time 
Before you start trading, you’ll want to launch the MetaTrader platform and become familiar with its workspace. In this 
section, you’ll receive an overview of the tools and features that you’ll use while trading in MetaTrader. 

Viewing the MetaTrader Workspace 
The MetaTrader workspace contains all the features and charts you need to trade.  

 

• Menu Bar 

• Toolbar 

• Market Watch 

• Navigator 

• Terminal  

• Status Bar 

• Chart window 

 

MetaTrader has a customizable interface. You can open, move, arrange, resize and close windows as you see 
fit. 
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The Menu Bar 
At the top of the workspace, you’ll see the MetaTrader menu bar. You can use options in the seven menus that appear here 
to manage windows and other tools while you trade. 

 

File – Displays menu options for opening and printing charts, managing chart profiles and displaying account information.  

View – Contains menu options for displaying MetaTrader windows and toolbars. You can also manage your language 
preferences and access the Strategy Tester from this window.  

Insert – Displays menu options for displaying indicators, drawing and analytic objects and text in the chart window.  

Charts – Contains menu options for managing the appearance of the chart window. You can change the time frame and 
chart type as well as display grid features.  

Tools – Contains tools for placing orders, displaying the History Center, accessing MetaEditor and customizing the 
interface.  

Window – Displays menu options for arranging the windows in the MetaTrader workspace.  

Help – Contains menu options for displaying MetaTrader online help, accessing the MQL.4 (the MetaTrader programming 
language) community and viewing version information. 

 

MetaEditor is an application installed with MetaTrader that enables traders to import, create and modify 
expert advisors, custom indicators, scripts and other autotrading tools. See Section 4: Opening MetaEditor 
for the First Time for more information. 

MetaTrader Toolbars 
MetaTrader groups its most commonly used tools on four toolbars. You can access these by clicking the View menu, 
selecting Toolbars and then clicking on the menu option for the toolbar you want.  

 

The Standard toolbar contains tools for displaying windows in the MetaTrader workspace.  

 

The Charts toolbar displays tools for managing the appearance of the chart window. 

 

The Line Studies toolbar contains tools for displaying drawing and analytic objects and text in the chart window. 

 

The Periodicity toolbar displays tools for managing time frames of the chart window.  

 

You can customize all of the toolbars so that they contain only the tools that you use. For more information, 
see Customizing the Toolbars in Section 6: Customizing the Appearance and Settings in MetaTrader. 
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The Market Watch Window 
You can monitor the real-time bid and ask prices of the available instruments in the Market Watch window. These are 
displayed on two tabs. 

  

The Symbols tab displays a list of instruments to trade and their prices.  

The arrow beside the instrument symbol shows if the price is rising or falling. The Bid and Ask prices will appear in a 
different colour. If the price is lower than the last reported one, the numbers appear in red. If the price is higher than the 
last reported one, the numbers appear in blue.  

You can double-click on an instrument to view the Order window and place an order to trade. See Placing Market Orders 
Manually from the Order Window in Section 2: Opening and Managing Your Trades for more information. 

If you right-click on an instrument when the Symbols tab is selected, you can access a drop-down menu with several 
options.  

New Order displays the Order window. Chart Window opens a new chart window. Tick Chart changes the Symbols tab 
to the Tick Chart tab. We’ll discuss each of these windows in upcoming sections of this guide.  

You can customize the Market Watch window so that it hides instruments as long as there are no open positions or 
pending orders attached to it. Hide removes a single instrument symbol from the window. Hide All temporarily removes 
all instrument symbols in the window. Show All displays the list of all available instruments.  

 

If you accidentally remove an instrument from the Symbols tab, you’ll need to right-click in the window and select 
Symbols. This displays the Symbols window where you can select the instrument you want to appear in the Market Watch 
window by clicking Show or Hide. Hidden instruments will have a gray symbol next to their name.  
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You can view information, such as pricing and size, for each instrument by clicking Properties. See Viewing Pricing and 
Contract Information in Section 2: Opening and Managing Your Trades for more information. 

 

When you hide an instrument in the Market Watch window, that instrument will also be hidden in other tools 
as well. For example, if you want to open a chart of the AUD/CAD, but the currency pair is hidden, it will not 
appear in the drop-down menu when you click the File menu and select New Chart. 

Once you set up the Symbols tab so that it’s only showing the instruments that you want, you can save the group of 
instruments as a set by right-clicking in the Market Watch window, selecting Sets and clicking Save As… If you change 
which instruments are displayed, you can always return to that set of instruments by right-clicking in the Market Watch 
window, selecting Sets and clicking on the name of the set.  

 

While you can view the instrument symbol and the prices in the Symbols tab, you can also view more information by right-
clicking in the window; you can show the time that the bid and ask prices were recorded by selecting Time and the daily 
highs and lows by selecting High/Low.  

You can rearrange the instruments as desired by clicking on the symbol you want and dragging it to a new location. You 
can also change the appearance of the table by selecting Auto Arrange, which resizes the columns automatically if the 
Market Watch window size changes, or Grid, which displays lines between the rows and columns. 



  MetaTrader 4 and MetaEditor User Manual 

 

9 

 

You can click on the Tick Chart tab to display a chart of the selected instrument with its price movements measured by the 
tick. 

The Tick Chart captures the buy prices with a buy line (which appears in red when you first open MetaTrader). If you right-
click in the tab, you can view the ask price movements by right-clicking in the window and selecting Ask Line. This 
appears on the chart as a blue line. 

The Navigator Window 
As you trade, you’ll want to add indicators to chart windows as well as activate MetaTrader’s autotrading tools, such as 
expert advisors, custom indicators and scripts. The Navigator Window is where you can view all of the available tools.  

 

The Navigator window is divided into two tabs. On the Common tab, you can select menu options from a grouped list. To 
display the available menu options, click + next to the group name. To hide them, click – next to the group name. 

Accounts displays the list of open accounts. If you have more than one account, you can use this menu to login to another 
account. If you right-click on an account, you can access a drop-down menu which includes options to login to an account, 
delete an account, or open a new practice  account.  
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Indicators shows a list of up to 100 different technical indicators (depending on your account type) that you can add to 
the chart window. Many traders use technical indicators to forecast where the market may be going. You can right-click on 
the indicator you want and click Attach to Chart from the drop-down menu to display it in a chart window.  

Expert Advisors contains a list of all available expert advisor strategies; these are programs that automatically analyse 
market conditions and place trades based on criteria you set.  

Custom Indicators displays a list of trader-modified technical indicators.  

Scripts contains a list of available scripts; these are programs that perform a single trading action once.  

 

You can download expert advisors, custom indicators, scripts and libraries from other sources or create them 
in MetaEditor, an application installed with MetaTrader that develops autotrading tools. See Section 4: 
Opening MetaEditor for the First Time to learn more about MetaEditor and Section 5: Using MetaTrader’s 
Autotrading Tools for more information on these tools. 

 

If you right-click on a specific indicator, expert advisor, script or custom indicator, you can select Add to Favorites from 
the drop-down menu. You can then view these on the Favorites tab on the Navigator window. 

The Chart Window 
The chart window plots the real-time prices of an instrument on a graph and provides a snapshot of market movements 
over a particular period of time. 
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Prices appear on the right side of the chart and the time and date appear along the bottom.  

There are several ways to open the chart window. One of the most common is to right-click on an instrument in the Market 
Watch window and select Chart Window. 

 

You can open more than one chart at a time (up to 99 can be displayed). When the Charts Bar is active, you can switch 
between them by clicking the instrument tab at the bottom of the window.  

You can customize the chart window using the tools in the Chart toolbar. See Displaying the Chart Toolbar in Section 3: 
Using the Chart Tools for more information on the chart window.  

 

If you do not see the tabs on the bottom of your chart, click the View menu and make sure Charts Bar is 
check marked. 

The Terminal Window 
You can monitor your trading activity, manage your expert advisors and perform other trading tasks in the Terminal 
window. This usually appears at the bottom of the MetaTrader workspace. These features are arranged in the window on 
several tabs.  

 

If the Terminal window is not displayed, you can view it by clicking the View menu and selecting the Terminal 
menu option. 

 

The Trade tab displays your open positions and pending orders. This is where you’ll manage all of your trades.  

 

While the Trade tab contains fields for balance, equity and margin data, you should not use these to moderate 
your account. When you sign up for MetaTrader 4, you will also receive access to DealBook WEB, which 
displays the most accurate trading activity on your account. At GFT, all transaction/order history information 
that appears in DealBook® WEB is considered the most accurate and legally-binding. Because of this, we 
recommend that you have both MetaTrader 4 and DealBook® WEB open when trading to compare equity 
values. If you have questions about this, contact GFT. 

 

The Account History tab compiles a list of all executed trades. You can also view your profit and loss, credits, deposits and 
withdrawal information.  
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The News tab displays all the latest streaming financial news.  

 

The Alerts tab shows a list of alerts. You can also use this tab to set alarms to notify you when an instrument has either 
reached a specific price or crossed an indicator trend line. See Viewing and Setting Alerts in Section 2: Opening and 
Managing Your Trades for more information.  

 

The Mailbox tab displays electronic messages sent to MetaTrader by GFT.    

 

The Experts tab shows information about the expert advisors that are active in your account. You can also view positions 
the expert advisor opened or closed. 

 

The Journal tab displays system messages about your account, such as login times, orders filled or edited and positions 
closed. 

 

Not all tabs will appear when you first open the Terminal window. For example, the Experts tab does not 
appear when you first open MetaTrader. This tab remains hidden until you receive input from MetaEditor, an 
application installed with MetaTrader that enables traders to import, create and modify expert advisors, or 
another MQL4 program. See Section 4: Opening MetaEditor for the First Time for more information. 
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The Data Window 
The Data Window displays price information for the instrument in the displayed chart. You can view the open, high, low 
and close as well as the date, time and volume. When an indicator or a custom indicator has been attached to a chart, you 
can view information about it in this window.  

 

You can right-click in the Data Window to view the following menu options.  

Copy allows you to copy information from the Data Window.  

When checked, Last Data displays a column in the Data Window which contains the latest open, high, low and close. 

When checked, Auto Arrange automatically resizes the columns in the Data Window if the window size changes. 

When checked, Grid displays a border around the rows and columns in the Data Window.  

You can choose which information appears in the Data Window by selecting Show and then checking or unchecking the 
options in the drop-down menu.  

The Strategy Tester 
With MetaTrader, you can create expert advisors to help you analyse markets and make trades. The Strategy Tester 
window allows you to test expert advisor strategies against already saved market history data and modify expert advisors 
as needed.  

 

The Settings tab is where you specify which expert advisor, the testing period, modelling and other information.  

The Journal tab displays a list of system messages about the expert advisor’s test, such as orders filled and positions 
closed. 
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The Results tab displays a table that contains information about all of the trades that were executed during the test.  

The Graph tab shows the test results. After a test, you can view a graph which maps your balance (with a blue line) and the 
number of lots (with a green line). You can view this information in a legend that appears in the upper left corner.   

The Report tab displays statistics about how the test was performed. 

The Optimization Results tab displays a table that contains information about all of the trades that were executed during 
the optimization. 

The Optimization Graph tab displays a graph which maps your profitable trades (in a green line) and your unprofitable 
trades (in a red line). 

 

Not all tabs will appear when you first open the Strategy Tester window. For example, the Results tab, Graph 
tab and Report tab appear only after the expert advisor has been tested. The Optimization Results and 
Optimization Graph appear only when an expert advisor has been optimized. See Testing an Expert Advisor in 
Section 5: Using MetaTrader’s Autotrading Tools. 

Generating MetaTrader 4 Reports in DealBook® WEB 
When you sign up for a GFT live account with MetaTrader 4, you will also receive access to a special version of 
DealBook® WEB, which you’ll use to generate your reports and statements. You’ll use your MetaTrader 4 login to access 
this.  

 

If you have a practice account, you will not receive DealBook® WEB access. 
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While you won’t be able to place trades from this version of DealBook®, it will show you the most accurate transaction and 
order history on your MetaTrader 4 account.  

Generating reports in DealBook® WEB: 

1. Open DealBook® WEB.  This link is sent to you when you open an account. 

2. Enter your username and password. Click >> to login. 

3. Select the report you want from the Type of Report drop-down menu.  

4. Enter the dates you want in the From and To dates. Depending on the report, you may also be able to choose other 
options.  

5. Click Show Report to generate the report.  

 

With live accounts, GFT recommends having both MetaTrader 4 and DealBook® WEB open when trading to 
compare equity values. Please remember that the equity value in DealBook® WEB is the most accurate and 
legally-binding. You should rely on this value when you are trading. If you have questions about the difference 
between the two platforms, contact GFT. 
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Section 2: Opening and Managing Your Trades 
Now that you’re familiar with some of the windows in MetaTrader, we’ll look at the tools you’ll use to place and monitor 
your trades. This section describes the various order types that are available in MetaTrader and the tools you can use to 
manually manage your orders in the market. 

Trading with the Order Types in MetaTrader 
When you trade with MetaTrader, there will be times when you need to manually place an order to open a position in the 
market. MetaTrader allows you to do this using several types of trading orders.  

 

Orders in MetaTrader will be filled at the nearest market price. Sometimes, this may be worse than the price 
you requested. This is called slippage. Slippage is possible on all orders.  

Market Order – Places a buy or sell order on an instrument at the current market price. 

Pending Order – Enters your order when the market reaches a specific price.  

 

There is a difference between orders and positions. All trades are placed as orders. When the price of the 
order meets the market price, it becomes an actively traded position. You can modify and cancel orders, but 
you can only close positions. 

When you select pending order, you can choose one of four types of orders: 

• Buy Limit - Places a buy order at a specific ask price. When you place a buy limit, the price should be below the 
current market price.  

• Sell Limit - Places a sell order at a specific bid price. When you place a sell limit, the price should be above the 
current market price.  

• Buy Stop – Places a buy order at a particular ask price. When you place a buy stop, the price should be above the 
current market price. 

• Sell Stop – Places a sell order at a particular bid price. When you place a sell stop, the price should be below the 
current market price. 

Take Profit – Places an order to exit an active position to capture profits you may have.  

Stop Loss – Places an order to exit an active position to minimize any losses you may have.  

Trailing Stop Orders – Places a stop order at a specific number of points away from the current market price. Once the 
market moves in your favour by that number, that stop loss order will then automatically update as long as the market 
moves your way so that it ‘trails’ the current price by the number of points you set. When the market moves against your 
position after the trailing stop loss has been set, the stop loss remains set at the last trailing price that it reached when the 
market was moving in your favour. You can use this to help protect profits without limiting any potential gains on your 
open positions. 

 

In MetaTrader 4, trailing stops will run as long as you are logged into the platform. 

If you set a trailing stop and then log out of MetaTrader before the market moves in your favour by the 
number of points that you entered, then the trailing stop loss order will not be placed.  

If you set a trailing stop and log out of MetaTrader after the market moves in your favour, triggering the 
trailing stop, the stop loss order will not trail the market. It will work as a hard stop at the last price that the 
stop loss was at when you logged off. 

When you log back into MetaTrader 4, if the stop loss hasn’t been triggered, it will resume trailing the current 
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market price by the number of points that you specified between the stop and the current price.  

    
Viewing Pricing and Contract Information 
Before you place an order, you’ll want to monitor the price and determine a good point to enter the market. You’ll also 
want to pick points for your take profit or stop loss orders. You can monitor prices and view contract information in the 
Market Watch window. 

 

You can monitor the real-time bid and ask prices of the available instruments in the Market Watch window.  

In addition to the Market Watch window, you can also view the Popup Prices window. Like the Market Watch window, this 
displays a list of symbols and prices. You can view this by right-clicking in the Market Window and selecting Popup Prices. 

 

If you right-click on the Popup Prices window, you can choose how you want the window to appear on screen. Always on 
Top displays the Popup Prices window on top of other applications. Full Screen expands the window so it fits your entire 
computer monitor. When selected, a checkmark appears next to the menu option in the drop-down menu. You can 
deactivate the option by unchecking the menu option.  



  MetaTrader 4 and MetaEditor User Manual 

 

18 

 

Before you trade, you may want to see the spread, margin, contract size and other details about the instrument you are 
interested in trading. You can view contract information by right-clicking in the Market Watch window and selecting 
Symbols. When the Symbols window appears, select the instrument you want and click Properties. This opens the 
Contract Specification window for the instrument you selected.  

Viewing the Order Window 
In MetaTrader, you’ll place most of your manual orders using the Order window.  

 

There are several ways to open the Order window:  

• Select New Order from the Tools menu.  

• Click  in the Standard toolbar.  

• Double-click on an instrument in the Market Watch window. 

• Right-click on a position in the Terminal window and select New Order from the drop-down menu.  

Once open, you can use the following features to specify your trade:  

• Chart – View the current by-tick price movements of the instrument. The blue line represents the current ask price 
and the red shows the current bid price.   

• Symbol – Select an instrument to trade. 

• Volume – Specify the number of lots you want to trade.  

• Type – Choose whether your order is a market order or a pending order. 
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In MetaTrader, 1.0 equals 100,000 units and .10 equals 10,000 units. 

Placing Market Orders Manually from the Order Window 
When you first open the New Order window, the Type menu is set to Market Execution so you can place market orders.  

 

The Market Execution section displays the current price and options for placing your trade.  

If the market is particularly volatile, it may take a few seconds for GFT to process your order. MetaTrader displays a 
pending message, a progress bar to show you how much further the trade has to process and a Cancel Order button, if 
you no longer want to place the order. 

Once the order is processed, the Order Execution section appears in the Order window. This displays a confirmation 
message, informing you that your trade was successful. From this message, you can print out the order information by 
clicking Print or close the window by clicking OK.  

Placing a Market Order:  

1. Double-click an instrument in the Market Watch window. 

2. Make sure the instrument you want is selected. Click the Symbol drop-down menu to select an instrument, if not.  

3. Click Volume drop-down menu to select the number of lots you want to trade.  

4. Make sure Market Execution is selected in the Type drop-down menu.  

5. If desired, enter text in the Comment text box. 

6. Click either the Sell by Market or Buy by Market button.  

7. Click Print to print the order information, if desired.  

8. Click OK to close the window.  

 

While you can open the Order window a number of different ways, our examples access the Order window by 
double-clicking in the Market Watch window. 
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Placing Pending Orders Manually from the Order Window  
You can also place pending orders; these enter your order when the market reaches a specific price. 

 

The Order window displays some of the same fields as it does when you enter a market order. When you select Pending 
Order from the Type menu, a new section, Pending Order, appears. You can select what kind of pending order you want, 
the price and the expiration date of the trade.  

If you are using a pending order to enter the market, you can enter a specific price in the At Price text box.  

You can specify how long you want your pending order to be available by using the Expiry checkbox. After you click the 
checkbox, you can select a specific expiration date and time.   

Selecting Pending Order also opens the Stop Loss and Take Profit text boxes. If desired, you can set the prices you want 
for these orders.  

If you place a stop loss or take profit order, the chart in the Order window displays a line representing these pending 
orders.  

If you enter an inappropriate price for either the Stop Loss or Take Profit text boxes and click Place to enter your order, 
MetaTrader displays a notification message. If you are entering both types of pending orders, MetaTrader lets you know if 
the stop loss (SL) or take profit (TP) is wrong. Click OK and then adjust the price. 

Placing a Pending Order: 

1. Double-click an instrument in the Market Watch window. 

2. Make sure the instrument you want is selected. Click the Symbol drop-down menu to select an instrument, if not.  

3. Click Volume drop-down menu to select the number of lots you want to trade.  

4. Click Type and select Pending Order.  

5. In the Pending Order section, select one of the pending order types from the Type drop-down menu.  

6. Enter the price.  

7. Click the Expiry checkbox and select a date.  

8. If desired, enter a price in the Stop Loss or Take Profit text boxes.  

9. Click Place.  

10. Click Print to print the order information, if desired.  
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11. Click OK to close the window.  

Managing Your Orders  
Once you place a trade, you’ll want to view your open positions and pending orders as well as your closed trades. You can 
do so on two tabs in the Terminal window.  

 

You can manage all of your open positions and pending orders in the Trade tab of the Terminal window. You can also view 
your balance, equity and margin data in this tab.  

When you right-click in a position row, you can select menu options to open an order, modify or delete an order or close 
an order.  

You can also right-click in the tab and select menu options to add the Commissions, Taxes and Comments columns to the 
table. You can also choose to display the value in the Profit column in points, term currency or deposit currency. 

Viewing Your Account History 
You can view all of your executed trades on the Account History tab of the Terminal window. Here, you can also view your 
profit and loss, credits, deposits and withdrawal information.  

 

When you right-click in a position row, you can select menu options to filter and sort the orders that appear in the tab by 
the last three months, last month, or a custom period. If you sort the orders, you can also click All History to view all 
orders again. 

When you select Custom Period, you can use the From and To drop-down menus to select specific dates.  

On both tabs, you can also change the appearance of the table by selecting Auto Arrange, which resizes the columns 
automatically if the Terminal window size changes, or Grid, which displays the lines between the rows and columns. 

 

With live accounts, GFT recommends viewing your account history in both MetaTrader 4 and DealBook® WEB. 
The transactions and values you see in DealBook® WEB are the most accurate and legally-binding. You should 
rely on these values when you are trading. If you have questions about the difference between the two 
platforms, contact GFT. 

 

Placing a Trailing Stop on an Order 
On the Trade tab of the Terminal window, you can modify or close your pending orders by right-clicking on an order row 
and selecting the menu option you want. One way to modify your order or position is to add a trailing stop. 
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In MetaTrader 4, trailing stops will only run when you are logged into the platform. For more information on 
how trailing stops work, see Trading with the Order Types in MetaTrader. 

 

To place a trailing stop quickly, right-click in a position row and select Trailing Stop. This displays a drop-down menu 
where you can select the number of pips you want (10 points = one pip). 

Once active, the trailing stop appears in the S/L column of the Trade tab.  

The Trailing Stop drop-down menu also contains the Custom… menu option. When you select this, you can enter a 
specific number of points in the Custom window.  

 

If you place a trailing stop and eventually want to remove it, you can right-click on your order or position, select Trailing 
Stop and click None.  

You can also remove all trailing stops from your open positions by selecting Delete All in the Trailing Stop drop-down 
menu. 

Placing a Custom Trailing Stop: 

1. Right-click in a position row in the Trade tab of the Terminal window and select Trailing Stop.  

2. In the drop-down menu that appears, select Custom… 

3. Enter number of points you want.  

4. Click OK.  

 

When you set a trailing stop, your stop needs to be more than 15 points away from the current price. 
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Closing a Position at the Current Market Price  
When you need to close a position at the current market price quickly, you can right-click in a position row and select 
Close Order to open the Order window and close your order. 

 

The Open window appears with a Close… button that displays the instrument, volume and order number.   

 

 Closing a Position at the Current Market Price: 

1. Right-click in a position row in the Trade tab of the Terminal window and select Close Order to open the Order 
window.  

2. When the Order window appears, click Close… by Market.  

3. Click Print to print the order information, if desired.  

4. Click OK to close the window.  

 

You can also double-click on the position row you want to open the Order window. 

 

 

You can also reverse your position by clicking the Sell by Market or Buy by Market buttons. 
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Closing Offsetting Positions 
If you have two offset positions in the same currency pair in the same size, you can use the Multiple Close By menu option 
to close out opposing positions for the currency pair selected. 

For example, let’s say you have two long EUR/USD positions and one short EUR/USD position in MetaTrader 4.  

 

You can use Multiple Close By to close the offset positions. 

 

Once this is executed, there will be one remaining long position open. 

 

Closing Offsetting Positions:  

1. Right-click in a position row in the Trade tab of the Terminal window and select Close Order to open the Order 
window.  

2. From the Order Type drop-down menu, select Close by Market.  

3. When the Order window appears, click Multiple Close by….  

4. Click OK to close the window.  

Protecting a Position with Stop Loss and Take Profit Orders 
Once your order becomes a position, you can view it on the Trade tab in the Terminal window. If you didn’t specify a stop-
loss or take-profit order when you first placed your order, you can add those orders by right-clicking in a position row and 
selecting Modify or Delete Order to open the Order window.  
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You can see if a position has a stop-loss or take-profit order associated with it by looking at the Stop Loss (S/L) or Take 
Profit (T/P) columns in the Trade tab of the Terminal window. In the Order window, the Stop Loss and Take Profit text 
boxes will display zeroes if no orders were placed when the original order for the positions was placed.  

When you open the Order window from the Trade tab, it displays the Modify Order menu option in the Type drop-down 
menu and appears already set with details about the position’s original order. You can specify information about your 
stop-loss or take-profit orders in the Modify Order section.  

You can click the Level text box and enter in a new number. When you enter a number of points, you can view what the 
price would be in the Copy As buttons. If this price seems right, click Copy As to have the price appear in the Stop Loss or 
Take Profit text boxes.  

If you enter an inappropriate price for either the Stop Loss or Take Profit text boxes, MetaTrader disables the Modify… 
button in the window. You need to correct the prices to enable this.  

Protecting a Position with Stop Loss and Take Profit Orders: 

1. Right-click in a position row in the Trade tab of the Terminal window and select Modify or Delete Order to open the 
Order window.  

2. Make sure Modify Order is selected in the Type drop-down menu.  

3. In the Modify Order section, enter the number of points in the Level text boxes. 

4. Click the Copy As button above the Stop Loss or Take Profit text box.  

5. If you want to add both a stop loss and take profit order to the position, repeat steps 3 and 4 for the other order.  

6. Click Modify… 

7. Click Print to print the order information, if desired.  

8. Click OK to close the window.  

Modifying Pending Orders 
If you’ve already placed a stop-loss and take-profit order or you have a pending order, you can manually modify these by 
right-clicking an order in the Trade tab of the Terminal window and selecting Modify or Delete Orders.  
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When you modify a pending order, the Symbol, Volume and other text boxes are greyed out. You cannot edit these.  

Modifying Pending Orders: 

1. Right-click in a position row and select Modify or Delete Orders to open the Order window.  

2. From the Type drop-down menu, select Modify Order.  

3. Change the price in the Stop Loss or Take Profit textboxes, if desired.  

4. Click Modify… 

5. Click Print to print the order information, if desired.  

6. Click OK to close the window.  

Deleting Pending Orders 
If market conditions change and you don’t want your pending orders to become positions, you can manually delete your 
order by clicking Modify or Delete Orders. 

 

Deleting Pending Orders: 

1. Right-click in a position row and select Modify or Delete Orders to open the Order window.  

2. Click Delete.  

3. Click Print to print the order information, if desired.  

4. Click OK to close the window.  
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Viewing and Setting Alerts 
As you trade, you can set alerts to notify you when an instrument has reached a specific price on the Alerts tab in the 
Terminal window.  

 

You can create or modify the alert settings in the Alert Editor. This is where you can set conditions and specify the sound to 
play for your alert.  

 

You can choose to be alerted when the instrument price is less than the bid price (Bid >), greater than the bid price (Bid 
<), less than the ask price (Ask >) or greater than the ask price (Ask <). You can also set the alert to occur at a certain time 
(Time =).  

 

MetaTrader will play a sound file if the application is open when the alert goes off. If you plan on closing the application, 
you can use the Action drop-down menu to select an alternate way to be notified: select Mail to receive an email, or File 
to receive a file. 

If you choose Sound from the Action drop-down menu, you can select the sound file you want to play from a drop-down 

menu. If you have other sound files that you would like to use on your computer, you can click . This opens the Open 
window and you can navigate to the folder where your sound files are stored. When you find one, click on it and select 
Open. 

To see what the alert would sound like, you can click Test in the Alarm Editor window. 

If the alert is designed to hit a price and the market bounces around that price, your alert may go off more than once. You 
can use the Timeout drop-down menu to set a period of time between when the alert goes off and when it can go again.  

You can use the Maximum Iterations drop-down menu to choose to have the alert sound between one and 1000 times.  

 

MetaTrader will send an alert to your email when your address is setup in the Email tab of the Options 
window. See Entering Email and Server Settings in Section 6: Customizing the Appearance and Settings in 
MetaTrader for more information. 
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Creating an Alarm:  

1. Right-click on the Alerts tab in the Terminal window and select Create. 

2. To begin entering information in the Alert Editor, click Enable On/Off.  

3. Click the Action drop-down menu and select Sound, File or Mail.  

4. Make sure the instrument you want is selected. Click the Symbol drop-down menu to select an instrument, if not.  

5. Click the Condition drop-down menu and select Bid >, Bid <, Ask >, Ask < or Time = and enter a value. 

6. Click the Source drop-down menu and select an alert. If you selected Sound, you can also click , select the file 
you want and click Open, if desired.  

7.  If desired, click the Timeout drop-down menu and select a time.  

8. If desired, click the Maximum Iteration and select a number.  

9. Click OK.  

 

When an alert is set, it appears in the Alerts tab. You can see how many times the alert has sounded in the Counter 
column.  

Once you’ve created an alert, you can right-click in the chart window and access other menu options.  

• Modify reopens the alert in Alert Editor so you can edit it.  

• Delete immediately removes the alert from the chart and the Terminal tab.  

• Enable On/Off allows you to turn the alert on or off. When enabled, the alert will display this icon in its row. When 

disabled, it will display this icon .  
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Section 3: Using the Chart Tools 
As you trade, you’ll discover that the chart window is essential for monitoring your trades, performing technical analysis 
and running expert advisors, custom indicators, scripts and other autotrading files. In this section, you’ll learn more about 
the chart window and the features you can use in it. 

Opening Charts  
In Section 1, you learned that the chart window plots the real-time prices of an instrument on a graph and provides a 
snapshot of market movements over a particular period of time. 

 

There are several ways to open the chart window.  

• Right-click an instrument in the Market Watch window and select Chart Window. 

• Click an instrument in the Market Watch window and drag it into the MetaTrader main window area.  

• Click New Chart in the File menu and select the instrument you want.  

• Click New Window in the Window menu and select the instrument you want. 

• Click the Chart Window button in certain windows. 

• Click  in the Chart toolbar. 

You can open up to 99 charts at one time and switch between them by clicking on the instrument chart tab at the bottom 
of the chart window.   

When you open a chart, MetaTrader displays the available price history for that chart. The amount of time shown depends 
on the time frame you selected and the settings in the Charts tab. See Specifying Chart and History Data Properties in 
Section 6: Customizing the Appearance and Settings in MetaTrader for more information.  
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Opening Charts Offline 
Some traders prefer to open offline charts. These show you the available price history, but do not update to show the real-
time prices of the instrument.  

 

You can open an offline chart by clicking the File menu and selecting Open Offline. This opens the Open Offline Chart 
window, where you can view the available instruments and time frames as well as how many bars, candles or line ticks are 
available in the chart.  

To open one, select the chart you want and click Open.   

When the chart opens, you’ll see (Offline) appear in the chart header. 

Viewing the Chart Window  
Once the chart window is open, you’ll notice a few features. 
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The Price section displays the current market prices of the instrument. 

The legend shows the instrument symbol and current price information.  

The Time Frame Interval section displays times and/or dates, based on the selected time frame. 

The Ask Line shows the current ask price.  

When you open a chart window for the first time in MetaTrader, the chart displays the price movements of the selected 
instrument as a continuous line, measuring intervals by the minute. 

The amount of time shown in the chart depends on the time frame you selected. For example, if you selected the five-
minute time frame on a line chart, you can view the closing price of an instrument for the five-minute period.  

You can scroll back and forth in the chart history by clicking in the chart window and dragging your cursor to the left or 
right.  

You can also change the scale of the price moves in the chart by clicking the Price section and dragging up and down or 
clicking the Time Frame Interval section and dragging left or right.  

 

You can change colours, fonts and other settings in the chart. For more information, see Customizing the 
Appearance of the Chart Window in Section 6: Customizing the Appearance and Settings in MetaTrader. 

Displaying the Chart Toolbar 
When you first open MetaTrader, you’ll notice the Chart toolbar appears at the top of the window. You can use these tools 
to change and manage the way the chart displays pricing information.  

 

If you don’t see the Chart toolbar, you can display it by selecting View, clicking Toolbars and selecting Charts. 

 

MetaTrader groups the tools on the toolbar by type. The first three buttons on the toolbar specify the chart type. If you 
click one, it remains active until you click another chart type button.  

•  Bar Chart displays the price moves of the selected instrument as a sequence of bars. Each bar displays the high, 
low, open and close of the instrument and represents the trading activity for the time frame selected in the chart. 

•  Candlestick Chart tracks the price moves of the selected instrument as a sequence of blocks or candles. Each 
candle displays the high, low, open and close of the instrument and represents the trading activity for the chart time 
frame. With candlesticks, you can analyse the market, spot trends and forecast their direction. 

•  Line Chart displays the price moves of the selected instrument as a continuous line. The line connects the close 
prices for the time frame selected in the chart. 

•  Zoom In magnifies the most recent price moves and displays them on the chart.   

•  Zoom Out decreases the magnification of the chart.  

•  AutoScroll updates the chart so that it always scrolls to the right to show the latest price moves.  
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•  Chart Shift arranges the chart so the latest price moves appear at a certain point in the chart. When active, you 
can click the triangular marker at the top of the chart window and set it anywhere between the right side of the chart 
and the middle of the chart.  

•  Indicators displays a drop-down menu with indicators. You can select between the most commonly used 
indicators or click the folder where the indicators are organized by type. When you select one, MetaTrader opens a 
window so you can specify settings for the indicator and then view it in or below the chart. For more information on 
indicators, see Managing Indicators in the Chart Window in this section.  

•  Period displays the selected time frame for the chart. You can also use this to change the time frame of the 
chart from one minute (M1) to one hour (H1) to daily. 

•  Templates displays a drop-down menu for loading and saving a chart template. With a chart template, you can 
save the chart type, time frame, indicators, expert advisors and other settings and apply it to any chart. For more 
information on templates, see Managing Templates in the Chart Window in this section. 

 

You can set the chart to zoom in to a precise point by checking the Scale Fix option in the Charts Setup 
window. See Customizing Viewing Settings on the Chart Window in Section 6: Customizing the Appearance 
and Settings in MetaTrader for more information. 

 

If you are scrolling through the chart and analysing chart history, make sure that AutoScroll and Chart Shift 
are deactivated. 

Selecting a Chart Type and Time Frame 
When you open the chart for the first time in MetaTrader, Bar Chart is selected in the Chart toolbar and One Hour (H1) 

selected in the Period  drop-down menu. You can change both of these at any time. 
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You can change the chart type by:  

• Clicking one of the buttons in the Chart toolbar to switch between bar, candlestick or line chart. 

• Clicking Charts in the menu bar and selecting the Bar Chart, Candlesticks or Line Chart menu options. 

When you first open MetaTrader, the chart types would look like this:  

Bar 

 

Candlestick 

 

Line  

 

There are several ways to change the time frame in the chart.  

• Click Period and select a time frame menu option from the drop-down menu. 

• Display the Periodicity menu bar by clicking View, selecting Toolbars and clicking Periodicity. You can then click the 
time frame icons.  

 

• Click Charts in the menu bar and select Periodicity. You can then select the time frame you want. 

• Right-click in the chart window, select Periodicity and then select the time frame. 



  MetaTrader 4 and MetaEditor User Manual 

 

34 

 

No matter which method you use, you can select one of the following time frames: 

• 1 Minute (M1) 

• 5 Minutes (M5) 

• 15 Minutes (M15) 

• 30 Minutes (M30) 

• 1 Hour (H1) 

• 4 Hours (H4) 

• Daily (D1) 

• Weekly (W1) 

• Monthly (MN) 

Switching Between Chart Time Frames and Instruments with Fast 
Navigation 
You can quickly switch between charts and time frames or scroll to a particular point in time on the chart using the Fast 
Navigation text box. You can display this field by double-clicking in the lower left corner of the chart.  

 

Once open, you can enter a specific time, date, symbol or all of these and press Enter on your keyboard. You can use the 
table below to see how to enter times and dates. 
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[time (hours:minutes)] example: 08:30; 8:30; 

[date] example: 2004.10.16; 16.10.2004; 16.10.04; 

[date and time] example: 2004.10.16 8:30; 16.10.2004 8:30; 16.10.04 8:30; 

[symbol] example: GBPUSD; EURUSD; 

[chart period] example: M1; M5; M15; M30; H1; H4; D1; W1; MN; 

[symbol], [chart period] example: GBPUSD, M30; EURUSD, D1; 

Displaying Other Tools in the Chart Window 
After you specify a chart type and time frame, you can set the chart window to display other tools to help you trade. 

 

Displaying a Grid 

When you first open MetaTrader, the chart displays vertical and horizontal grid lines. You can right-click in the 
chart window and select Grid from the drop-down menu to activate or deactivate it.  
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Displaying Trading Volume 

You can display the current trading volume for the selected instrument by right-clicking in the chart window and 
selecting Volumes from the drop-down menu.  

 

Refreshing the Chart 

During volatility, you may need to update the chart window. You can do so by right-clicking in the chart window 
and selecting Refresh.  
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Saving as a Picture 

You can save the active chart window or workspace as a .gif or .bmp file by right-clicking in the chart window and 
selecting Save As Picture... You can also choose the size the active chart to a specific pixel size.  

 

Printing the Chart 

You can print the active chart. To preview it before you print, right-click in the chart window and select Print 
Preview. When you’re ready to print, right-click in the chart window and select Print... 
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You can also access the tools listed here from the Charts or File menu in the menu bar. 

Displaying the Line Studies Toolbar 
If you are planning on drawing in the chart window, you may want to display the Line Studies toolbar. This contains a 
number of MetaTrader drawing tools.  

 

 enables you to click on other drawing objects and drag them to new locations in the chart. This is active when you 
first open the chart window.  

 

 turns your cursor into a cross when you move around the chart window. When this is selected, you can find out the 
distance between the points and the current price value by clicking on a point in the line and dragging to another point.  
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 adds a vertical line on the chart. These can be used to mark the beginning of a trend or specify a time when you 
entered the market. When this is selected, click in the chart to place the line.  

 

 adds a horizontal line on the chart. These can be used to plot a horizontal support or resistance level. When this is 
selected, click in the chart to place the line.  
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 plots a diagonal trendline drawn through a series of high or low price points in the chart window. When this is 
selected, click where you want your line to begin and drag your cursor to place the line. You can add multiple trendlines to 
the chart. 

 

 plots two parallel lines that remain equidistant, no matter where you place them in the chart window. When this is 
selected, click where you want the channel to begin and drag your cursor to place it. You can then click on the secondary 
line and drag it in the chart. 
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 draws six parallel lines at specific distances defined by the Fibonacci sequence (0.618, 1.000, 1.618, 2.618, 4.236). When 
it is selected, click where you want the channel to begin and drag your cursor to place it. 

 

 adds a label to a particular part of the chart. When selected, you can click in the chart window where the label should 
be. This opens the Text window with the Common tab displayed. Here, you can enter a name for the label, add the text 
you want and change the colour, size or font. You can also specify where the label should anchor on the Parameters tab or 
select if the text label should appear on all chart time frames on the Visualization tab.  
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 adds a comment to the chart window. As you scroll, the comment remains displayed over the chart. When selected, 
you can click in the chart window where the comment text should be. This opens the Label window with the Common tab 
displayed. Here, you can enter a name for the comment, add the text you want and change the colour, size or font. You can 
also specify the time and the angle of the comment on the Parameters tab or select if the text label should appear on all 
chart time frames on the Visualization tab. 

 

 displays a drop-down menu, so you can select from eight different types of icons to add to the chart window. If you 
add too many of these icons to the window, you select the Delete All Arrows menu option to remove all icons from the 
window.  

 

MetaTrader draws all trend lines on the charts as rays, lines which start at one point and continue in one 
direction toward infinity. You can change this using the Objects List. See Configuring Drawings in the Chart in 
this section for more information. 
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Drawing in the Chart  
As you trade, you’ll want to examine the chart, looking for possible patterns and trends in the price movements. 
MetaTrader offers a number of drawing tools so you can plot support and resistance levels, identify simple and complex 
patterns and create other notations on the chart. 

 

You can select over 30 different tools by clicking on the Insert menu in the menu bar and selecting the tool you want from 
the drop-down menu or its related menu. 

When you click Lines, you can select from one of four different types of lines to draw on the chart.  

Vertical Line places a vertical line in the chart window. When selected, click where you want your line to be to place it. 

Horizontal Line places a horizontal line in the chart window. When selected, click where you want your line to be to place 
it. 

Trendline allows you to draw a diagonal line through a series of high or low price points in the chart window. When 
selected, click where you want your line to begin and drag your cursor to place it. 

 

You can learn more about these three types of lines in the Displaying the Line Studies Toolbar in this section of 
the guide. 
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When Trendlines by Angle is selected, click where you want your line to begin and drag your cursor to place the line on a 
specific degree.  

 

Remember, you can change MetaTrader settings so all your trendlines have a beginning and end point using 
the Objects List. See Configuring Drawings in the Chart in this section for more information. 

Drawing Channels on the Chart 
When you click on the Insert menu and select Channels, you can select from one of four different types of channels to 
draw.  
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Fibonacci Channels draws six 
parallel lines at specific distances 
defined by the Fibonacci sequence 
(0.618, 1.000, 1.618, 2.618, 4.236). 
When it is selected, click where 
you want the channel to begin and 
drag your cursor to place it. 

 

Linear Regression is a statistical 
analysis tool that is used for 
forecasting future values of an 
instrument. When it is selected, 
click where you want the channel 
to begin and drag your cursor to 
place it. 
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Equidistant draws two parallel 
lines that remain equidistant, no 
matter where you place them. 
When it is selected, click where 
you want the channel to begin and 
drag your cursor to place it. You 
can then click on the secondary 
line and drag it in the chart. 

 

Standard Deviation draws three 
parallel lines that are separated by 
a set deviation. Once placed, you 
can click and drag the channel 
along the price moves and the 
channel distance will adjust based 
on those prices. When Standard 
Deviation is selected, click where 
you want the channel to begin and 
drag your cursor to place it. 

 

 

You can change the deviation in Standard Deviation lines by double-clicking on the line and then right-clicking 
to select StdDev Properties. On the Parameters tab, you can enter a new value in the Deviations text box. 

Drawing with the Gann Tools on the Chart 
W. D. Gann considered a 45-degree line to be significant when analysing market moves. Under certain market conditions, 
traders could draw a 45-degree line on a chart and forecast that moves above the line were bullish while those below that 
line were bearish. If price movements crossed the line, it indicated that the trend was changing. 

When you click on the Insert menu and select Gann, you can select from one of three different types of Gann tools to add 
to the chart. 
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A Gann line is a trendline 
drawn at an angle of 45 
degrees. When Gann Line is 
selected, click where you 
want the line to begin. 

 

 

A Gann fan displays a set of 
trendlines drawn from one 
point at different angles. 
When Gann Fan is selected, 
click where you want to 
place the fan. 

 

A Gann grid displays a series 
of intersecting 45-degree 
lines. When Gann Grid is 
selected, click where you 
want the grid to begin and 
drag your cursor to size the 
grid. 
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Drawing with the Fibonacci Tools on the Chart 
Leonardo Fibonacci discovered a number sequence where each successive number represents a sum of two preceding 
ones: 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144, etc. Many traders use these values to forecast points of support or resistance.  

When you click on the Insert menu and select Fibonacci, you can select from one of five different types of Fibonacci tools 
to add to the chart.  

When a severe drop or rise 
occurs, you can use a 
Fibonacci retracement to 
forecast where stops or 
losses may be placed. 
When Retracement is 
selected, click and drag a 
line between the highest 
and the lowest price points 
on the chart. 

 

You can add a Fibonacci 
expansion to forecast 
where the third wave will 
end.  

When Expansion is 
selected, click and drag to 
create a line between the 
highest and the lowest 
price points on the chart, 
just as you did for the 
retracement. When done, a 
second trend line will 
appear. You can double-
click on the trend lines to 
adjust the expansion.   
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A Fibonacci time zone 
consists of a series of 
vertical lines placed at 
Fibonacci intervals from 
each other. You can use 
Fibonacci Time Zones to 
forecast possible times 
when the market may 
experience a significant 
price change. When Time 
Zones is selected, you can 
create this drawing object 
by clicking and dragging. 

 

A Fibonacci fan displays a 
set of trendlines drawn 
from one point at different 
angles. You can use this to 
forecast support levels for 
a possible ascending or 
descending trend. When 
Fan is selected, click and 
drag to create a line 
between the high and the 
low. 

 



  MetaTrader 4 and MetaEditor User Manual 

 

50 

You can use Fibonacci arcs 
to forecast support and 
resistance levels. When 
Arcs is selected, click 
where you want the centre 
of your arc to be and drag 
to size the arc. 

 

Adding Shapes to the Charts 
When you click on the Insert menu and select Shapes, you can select from one of three different shapes to add to the 
chart. 

Rectangle draws a 
rectangle of any size on the 
chart. When this is selected, 
click where you want one of 
the corners of the rectangle 
to start and drag to size.   
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Triangle draws a rectangle 
of any size on the chart. 
When this is selected, click 
where you want the three 
corners to be. Once you 
place the third point, the 
triangle appears on the 
screen.  

 

Ellipse draws an ellipse of 
any size on the chart. When 
this is selected, click where 
you want the edge of the 
ellipse to be.  

 

 

 

You can change the colour, line style and other settings of the shapes you draw on the chart using the Objects 
List. See Configuring Drawings in the Chart in this section for more information. 
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When you click on the Insert menu and select Arrows, you can add eight different types of icons to the chart. 

Thumbs Up/Thumbs Down  

Up Arrow/Down Arrow  

Stop Sign  

Check Sign  

Left/Right Price Label 
 

 

 

You can also place all of these icons using the drop-down menu in the Line Studies menu bar. This also 
contains an option for removing all icons from chart window. See Displaying the Line Studies Toolbar in this 
section for more information. 

Using the Advanced Drawing Tools in the Charts 
The Insert menu also includes four other menu options for adding technical analysis drawing or label objects to the chart.  

Andrew’s Pitchfork is a set of three 
trendlines used to identify lines of 
support or resistance. If you suspect 
that a channel trend is forming 
around price movements in the 
chart, you can use this drawing 
object to verify your assumptions. 
When Andrew’s Pitchfork is 
selected, you can click on a high or a 
low to specify the middle of the 
pitchfork and then click two 
significant peaks or troughs beside it 
to compose the prongs. 
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Cycle Lines are a row of vertical 
lines placed at equal intervals. 
Usually, one interval corresponds 
with one cycle. When Cycle Lines is 
selected, click a point in the chart 
window and drag to adjust the 
interval. 

 

You can add a label to a particular 
part of the chart by clicking Text 
Label. As you scroll, the comment 
remains displayed over the chart. 
When selected, you can click in the 
chart window where the label 
should be. The Label window 
appears with the Common tab 
displayed. Here, you can enter a 
name for the label, add the text you 
want and change the colour, size or 
font. You can also specify where the 
label should anchor on the 
Parameters tab or select if the text 
label should appear on all chart time 
frames on the Visualization tab. 

 



  MetaTrader 4 and MetaEditor User Manual 

 

54 

You can add a comment to the chart 
by clicking Text. When selected, you 
can click in the chart window where 
the comment text should be. The 
Text window appears with the 
Common tab displayed. Here, you 
can enter a name for the comment, 
add the text you want and change 
the colour, size or font. You can also 
specify the time and the angle of the 
comment on the Parameters tab or 
select if the text label should appear 
on all chart time frames on the 
Visualization tab. 

 

 

Configuring Drawings in the Chart 
After you add a drawing to the chart, you can change its appearance and properties as well as add a label to it by right-
clicking in the chart window and selecting Objects List. This displays the Objects On… window.   

 

The Objects On… window shows a list of all objects that are currently displayed in the chart window. It also contains four 
command buttons. 
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Objects that are checked are currently selected and can be edited.  

Show changes the view of the chart window, so the currently selected object is prominently displayed.  

Delete removes the object from the Objects On… window and the chart window.  

Close closes the Objects On… window.  

Edit opens an edit window for the currently selected object. This window contains three tabs.  

 

The Common tab contains settings for entering the name for the object, adding a description and changing the colour, line 
style or other appearance settings of the selected object.  

Drawing objects like Rectangle and Ellipse appear filled. If you want to see just the outline of the shape, uncheck Draw 
Object as Background.  

 

The Parameters tab is where you can enter specific data on where the object appears in the chart. The selections available 
here depend on what the selected object is.   

The Time and Value fields enable you to specify where an object is placed on the chart.   

You can use the Angle in Degrees field to set the angle of the text or the drawing object.  

The Arrow Code field adds an object code when you add an arrow icon to the chart window.  

When selected, the Ray checkbox draws all lines on the charts as lines that start at one point and continue in one direction 
toward infinity. This is selected when you first open MetaTrader.  
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The Visualization tab contains settings so you can specify in which time frames the object will appear on the chart. When 
you first draw the object, Show on All Time frames is automatically selected.     

Editing Drawings in the Chart: 

1. Right-click in the chart window with your drawing objects and select Objects List.  

2. In the Objects On… window, select the object you want and click Edit.  

3. In the Common tab, make sure the name is correct and enter a description, if desired.  

4. Use the drop-down menus to specify the colour of the drawing object and the line style.  

5. Click on the Parameters tab and make changes as necessary.  

6. If you want to specify a time frame, click on the Visualization tab, uncheck Show On All The Time frames and check 
the time frames you want.  

7. When done, click OK.  

8. Select another object in the Objects On… window to edit, if desired.  

9. When done, click Close. 

 

If you don’t want to configure all of the drawings at once, you can also double-click on a single drawing object 
in the chart window to select it. Right-click on it and select the …Properties menu option. This will open the 
edit window for the currently selected object. 

Grouping Charts with Profiles 
MetaTrader allows you to open multiple charts and save them in a profile. Many traders use this to compare their most 
commonly traded instruments. You can use the Profiles menu option in the File menu to save multiple groups of charts.  
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When you click the File menu and select Profiles, you can:  

• Display one of the existing profiles by selecting its name from the drop-down menu that appears. When selected, 
a check appears beside it to show you that it is active. 

• Return to the original profile by choosing Default.  

• Move between profiles by clicking Next or Previous. 

• Save several charts already displayed as a set by clicking Save As… Once saved, it appears in the Profiles drop-
down menu with a check beside it to show you that it is active. 

• Delete a profile by clicking Remove and selecting the profile you want from the drop-down menu. 

When you open a profile, each chart window appears with its settings in the same location as it was when it saved.  

Saving a Profile:  

1. Click the File menu and select Profiles.  

2. When the drop-down menu appears, select Save As… 

3. In the Save Profile window, you can type in a new name or select an existing name from the drop-down menu to save 
over that profile.  

4. Click OK.  

 

If you make a change to the chart windows in a profile, you don’t have to save it. These are automatically 
saved in the current profile. 

 

The profiles in the drop-down menu or the Profiles folder on your computer may vary from the graphic that 
you see here. 

 

You can also use these commands by clicking  in the Standard toolbar. This displays a drop-down menu 
similar to the one that you see when you click the File menu and select Profiles. 
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Placing Trades from the Chart 
You can place trades from the chart by right-clicking in the window, selecting Trading and then clicking a menu option 
from the drop-down menu that appears.  

 

New Order  

Opens a position in the market at the current price. The Order window opens with a Market Execution order type 
selected. You can change the Type drop-down menu and select Pending Order if you want to place a buy limit or a sell 
stop.  

Buy Limit at.../Sell Stop at... 

Places a buy limit or a sell stop at the listed price. The Order window opens with the Pending Order type selected. 

Placing a Market Order from the Chart Window:  

1. Right-click in the chart window of the instrument you want, select Trading. 

2. From the drop-down menu, click New Order. 

3. Click Volume drop-down menu to select the number of lots you want to trade.  

4. If desired, enter text in the Comment text box. 

5. Click either the Sell by Market or Buy by Market button.  

6. Click OK to close the window.  

Placing a Pending Order from the Chart Window: 

1. Right-click in the chart window of the instrument you want, select Trading. 

2. From the drop-down menu, click Buy-Limit at.../Sell Stop at… order. 

3. Click Volume drop-down menu to select the number of lots you want to trade.  
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4. If desired, click the Expiry checkbox and select a date.  

5. If desired, enter a price in the Stop Loss or Take Profit text boxes.  

6. Click Place.  

7. Click OK to close the window.  

 

For more information, see Placing Market Orders Manually from the Order Window or Placing Pending Orders 
Manually from the Order Window in Section 2: Opening and Managing Your Trades. 

Managing Technical Indicators in the Chart 
Many traders use technical indicators to forecast where the market may be going. In MetaTrader, you can select up to 30 
different technical indicators to appear in the chart.  

There are several ways to add an indicator to a chart.  

• Click + next to Indicators in the Navigator window to display the list of indicators. Then click and drag the indicator to 
the chart window.  

• Right-click on the indicator you want in the Navigator window and select Attach to a Chart. 

 

• Click the Insert menu and select Indicators. This displays a drop-down menu where the indicators are organized in 
folders by type (Trend, Volumes, Oscillator, etc.). You can select the folder and click on the indicator in it.  



  MetaTrader 4 and MetaEditor User Manual 

 

60 

 

• Click  in the Charts toolbar. This displays a drop-down menu with a list of the most recently used indicators and 
then the indicator folders. You can select the indicator you want or click on the folder and select the indicator. 

When you add an indicator to the chart, a settings window for that indicator appears. You can specify settings for the 
indicator over several tabs. The ones that you see depend on the indicator you selected. 

 

The Parameters tab is where you can enter specific data on how the indicator appears in the chart. The selections available 
here depend on what the indicator is.  

On the Colors tab, you can modify the line colours of the indicator by double-clicking on the colour and selecting a new 
one from the drop-down menu. Like the Parameters tab, the selections that you see depend on what the indicator is. You 
can also specify line width on a scale of one to five by double-clicking on the Width row and selecting a new one from the 
drop-down menu that appears. If you select a line width of one, you can also specify whether the line appears as solid or 
dotted by double-clicking on the Style row and selecting a new one from the drop-down menu that appears. 

The Levels tab is where you can add level lines to the indicator. You can create a new level by clicking Add. You can then 
select the line and use the drop-down menus to change the colour, thickness and style of the level line. To remove lines, 
select the line and click Delete. 

On the Visualization tab, you can select in which time frames the indicator can be used. When you first open MetaTrader, 
the All Time Frames checkbox is selected. When you uncheck it, you can select one or more time frames.  

If you need to return to the original settings, click Reset. 
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Indicators will appear either in the chart or in an indicator window below the chart. The name of the indicator in the 
separate indicator window appears in the upper left corner of that window.  

 

You can add as many indicators to the charts as you would like, but GFT advises traders to use no more than five at a time.  

Attaching an Indicator to the Chart Window: 

1. Right-click on the indicator you want in the Navigator window and select Attach to a Chart. 

2. Select the options you want on the tabs that appear.  

3. When done, click OK.  

 

Indicators should not be confused with custom indicators. See Section 5: Using MetaTrader’s Autotrading 
Tools for more information on custom indicators. 

When an indicator is attached to the chart, you can right-click in the chart window and select Indicators List. This opens 
the Indicators on… window. You can use this to view the indicators already attached to the chart. When you select an 
indicator, you can click Edit to open the settings window for that indicator or click Delete to remove it from the chart.  
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If you use a particular indicator regularly, you can save it to your Favorites tab by right-clicking on it and 
selecting Add to Favorites. You can also set a hot key shortcut so you can activate an indicator by pressing a 
key or two on your keyboard. See Setting Keyboard Shortcuts for Autotrading Tools in the Navigator Window 
in Section 5: Using MetaTrader’s Autotrading Tools for more information. 

Managing Expert Advisors 
With MetaTrader, you can use automated trading strategies called expert advisors to perform prompt technical analysis of 
price data and manage trading activities based on current market conditions. When an expert advisor is attached to the 
chart, you can right-click in the chart window to modify, test and delete it.  

 

The EUR/USD chart window with the expert advisor, MACD Sample, attached. To show you that it’s attached, the name 
appears in the upper right corner of the chart window.  

 

If you are using an EA and do not have a Virtual Private Server subscription, your EAs will stop running when 
you log out of MetaTrader. 

You can verify if the expert advisor is active or not by looking for one of three types of icons in the upper right corner of 
the chart. A  means that the expert advisor was attached and is actively trading. A  shows that the expert advisor 
was attached, but that live trading is disabled for it. A means that all expert advisors have been disabled.  

 

For more information on expert advisors, see Section 5: Using MetaTrader’s Autotrading Tools. 
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Managing Templates in the Chart Window 
With a chart template, you can save the chart type, time frame, indicators, expert advisors and other settings and apply it 
to any chart.  

 

MetaTrader includes a number of already existing templates which you can select by right-clicking in the chart window and 
selecting Template. From the drop-down menu, select one of the listed templates. The chart window updates 
immediately.  

If you’ve used MetaTrader before and have template (.tpl) files, you can import these by placing them in the Templates 
folder on your computer. You can then import template files in MetaTrader using the Load Template… menu option.  

You may notice the default.tpl in the Templates folder. This is a basic template that is created during the MetaTrader 
installation and applied automatically whenever the chart window is opened. While you can edit this file, you cannot save 
over it.  

You can save the contents of the chart window as a template or save changes you’ve made to an existing template by 
using the Save Template… menu option. Once saved, the template appears by name in the list of templates. 

Loading a Template in the Chart:  

1. In the chart, right-click and select Template.  

2. From the drop-down menu, click Load Template. 

3. In the Open window, select the .tpl file you want and click Open. 

Saving a Template in the Chart: 

1. In the chart, right-click and select Template.  
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2. From the drop-down menu, click Save Template. 

3. If you are saving a new template, enter the file name you want. If you want your changes to overwrite an existing 
template, click that template file. 

4. When done, click Save. 

 

The templates in the drop-down menu or the Templates folder on your computer may vary from the graphic 
that you see here. 

 

You can also use these commands by clicking  in the Charts toolbar. This displays the same drop-down 
menu that you see when you right-click in the chart window. 

Closing Charts and Recovering Them 
As you trade, you may find it necessary to close chart windows. If you need to look at a chart that was closed, you can 
reopen them using the Open Deleted menu option in the File menu.  

 

You can reopen closed chart windows as long as the settings in the Charts tab in the Options window are set to do so. See 
Specifying Chart and History Data Properties in Section 6: Customizing the Appearance and Settings in MetaTrader for 
more information.  

To reopen a closed chart, click the File menu and select Open Deleted. In the drop-down menu that appears, select the 
instrument and time frame that you want.  
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Section 4: Opening MetaEditor for the First Time 
Before you use MetaTrader’s automated trading tools, you’ll want to learn a bit about MetaEditor, an application installed 
with MetaTrader that helps you develop autotrading tools. With MetaEditor, traders can import, create and modify expert 
advisors, custom indicators, scripts and other MetaTrader autotrading tools. Before you start downloading or coding 
autotrading files, you’ll want to open MetaEditor and become familiar with its workspace. In this section, you’ll receive an 
overview of the tools and features you’ll use to create MetaTrader autotrading tools. 

Opening MetaEditor 
MetaEditor is automatically installed on your computer when you install MetaTrader. You can open it while working in 
MetaTrader using one of the following methods.   

 

• Click the MetaEditor  button in the toolbar.  

• Right-click on an indicator, expert advisor, custom indicator or script and select Create, Modify or Online 
Library. 

• Click Tools and select MetaQuotes Language Editor from the drop-down menu.  
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If you do not have MetaTrader open, you can open MetaEditor by clicking the Start menu on your computer, clicking the 
MetaTrader folder and clicking MetaEditor. MetaEditor uses the same login as MetaTrader. 

Viewing the MetaEditor Workspace 
The MetaEditor workspace contains all the features you need to create MetaTrader autotrading tools, such as expert 
advisors, custom indicators, scripts and libraries.  

 

• Menu bar 

• Toolbar 

• Navigator window 

• Toolbox  

• File window 

• Status bar 

The Menu Bar 
At the top of the workspace, you’ll see the MetaEditor menu bar. You can use the five menus that appear here to access 
that MetaEditor options that you’ll use to create and edit autotrading tools.  
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File – Displays menu options for creating and opening autotrading tool files. You can also access recently opened files.  

Edit – Contains the menu option for finding and replacing a text string in an autotrading tool file.  

View – Displays menu options for displaying MetaEditor windows and toolbars. You can also manage your language 
preferences from this menu.  

Tools – Contains tools for accessing MetaTrader and arranging the windows in the MetaEditor workspace.  

Help – Contains menu options for displaying the MetaTrader online help, accessing the MQL.4 (the MetaTrader 
programming language) community and viewing version information. 

The MetaEditor Toolbar 
You can access the most commonly used tools on the MetaEditor toolbar. If this isn’t displayed, click the View menu and 
select Toolbar.  

 

 opens the Expert Advisor wizard. You can use this to immediately create an expert advisor, custom indicator, script, 
library or other autotrading tool.  

 displays the Open window. If you’ve previously created a file, you can click this to navigate to the file location and 
select it.  

 saves the code file of the autotrading tool you created. All MetaEditor files are saved as .mq4 files.  

 opens or closes the Toolbox window.  

opens or closes the Navigator window.  

 cuts a selected section of code in a .mq4 file.  

 copies a selected section of code in a .mq4 file. 

 pastes a selected section of code in a .mq4 file into another file.  

 reverses the last action you just completed.  

 repeats the last action you just completed.  

 verifies if the code in the open file works as programmed. The Errors tab opens automatically in the Toolbox 
window to show you if there are any errors or warnings. When the compilation is successful, MetaEditor saves the file. 

 switches your computer to MetaTrader.  

 displays help files based on what you click on. When active, the cursor appears with a question mark.  

You can customize all of the toolbars so that they contain only the tools that you use by clicking View and selecting 
Customize… This opens the Customizing Toolbar window.  



  MetaTrader 4 and MetaEditor User Manual 

 

68 

 

This window is where you can specify what appears in the selected toolbar. The Available section shows any menu options 
that are currently not in the toolbar and can be added. The Selected section displays all of the options that are currently 
displayed in the toolbar.  

The tools that appear in the Available and Selected section depend on which toolbar you right-clicked on.  

To place a tool on the toolbar, you can select it in the Available section and click Insert. Conversely, you can remove a tool 
from the toolbar by clicking it in the Selected section and then selecting Remove.  

You can also reposition the order of the tools in the menu bar by selecting a tool and clicking Up or Down.  

If you need to return to your original settings, click Reset.  

When you are done reordering the toolbars, click Close.  

The Toolbox Window 
You’ll use the Toolbox window to find and download user-community created autotrading files. You can also use this 
window to test recently downloaded or newly created files or search for specific code strings in the files. The Toolbox 
organizes these tools over four tabs. 

If the Toolbox window isn’t displayed, you can click in the View menu and select the Toolbox menu option. You can also 
click  in the toolbar.  
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The Errors tab displays a list of any errors that MetaEditor finds in the code file of the expert advisor, custom indicator or 

other autotrading tool. After you save the file you’re working on, you can click . The Errors tab then displays a 
list of any errors or warnings it found. 

 

To go to the line with the error, you can right-click in the Errors tab and select Go To Line from the drop-down menu that 
appears.  

 

You can use the Find in Files tab to search for a specific word or line of code in one or more autotrading files in a folder.  
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Click the Find in Files menu option in the Edit menu to open the search window. Type the word you want and use the 
drop-down menu to select the location you want. When done, click Find.  

 

You can view the list of files and the line in the Find in Files tab. To go to the line, you can right-click in the Find in Files 
tab and select Go To Line from the drop-down menu that appears. You can also double-click one of the results. The 
corresponding file is displayed with the cursor on the found text and the line is marked with a green arrow in the margin 
field.  

 

 

If you search for a line of code and then click the Find in Files menu option to start a new search, MetaEditor 
clears the Find in Files tab. 

 

The Online Library tab displays a list of trader created autotrading files. You can use the toolbar along the top of this 
window to switch your search between expert advisors, custom indicators, scripts and other files. You can use the scroll 

bar to move through the list. You can also click  to see if any new files have been added. When you find the 

item you want, select it and click . You can also right-click in the item row and select Download from the 
drop-down menu. This opens the source code file in the workspace. 
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The Help tab displays online help files for creating or editing the MetaTrader autotrading tools using the MetaQuotes 
Language 4 (MQL4). You can use the toolbar along the top of this window to navigate through the files to find the code 
you want. You can also use the Dictionary tab in the Navigator window to select specific topics to appear on the Help tab.  

If you right-click an item in any of these tabs, you can view a drop-down menu. The options that appear in the menu 
depend on the tab you selected. Some of the menu options that you may see are:  

 

 

 

Go to Line – This appears in the Errors tab and the Find in Files tab. Go to Line opens the corresponding file with the 
cursor on the found text and a green arrow in the margin field of the line. 

Copy – This appears in the Errors tab. It adds the selected error to the clipboard.  

Clear – This appears in the Errors tab and the Find in Files tab. Clear removes all of the displayed items from the tab.  

Open – This appears in the Online Library tab. It displays the selected item in the application.  

Download – This appears in the Online Library tab. Download opens the source code file in the workspace. 

Refresh - This appears in the Online Library tab. It updates the list to see if any new files have been added. 

Auto Arrange – This appears in the Errors tab, the Find in Files tab and the Online Library tab. When checked, Auto 
Arrange resizes the columns automatically if the tab window size changes. 

Grid – This appears in the Errors tab, the Find in Files tab and the Online Library tab. When checked, Grid displays lines 
between the rows and columns. 
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The Help tab menu contains the menu options that are in the toolbar on the tab.  

The Navigator Window 
You’ll use the Navigator window to view code files. You can use these to research how an autotrading tool works or to 
copy and paste existing code into a new autotrading tool. The Navigator window organizes these over three tabs. 

 

The Files tab displays the folders and files that are in the Experts folder of your computer. You can open these files by 
clicking the + to expand the folder and then double-clicking on the file you want.  
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The Dictionary tab shows code examples of the MQL4 language organized in books and files. You can open these files by 
clicking the + to expand the book and then clicking on the file you want; the topic you want opens in the Help tab of the 
Toolbox window.  
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The Search tab allows you to search the dictionary for a specific programming topic. When you enter words in the field and 

click , MetaEditor lists the search results in the tab. To view a result, double-click on the search result you want. Like 
the Dictionary tab, the topic you want opens in the Help tab of the Toolbox window. 

The Code Window 
The Code window is where you can view the text file that contains the source code of your expert advisor, custom 
indicator, script or other MetaTrader autotrading tools.  
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You can download existing autotrading tools using the Toolbox or create them using the Expert Advisors wizard. See 
Section 5: Using MetaTrader’s Autotrading Tools for more information.  

The source code is displayed in a basic text file. Once opened, you can copy and paste lines of code into the file or enter 
the code manually if you are familiar with MQL4.  

You can open more than one autotrading tool file at a time and switch between them by clicking the instrument tab at the 
top of the window.  

The Options Window 
You can use the Options window to specify font and style settings in the source code of the autotrading tool. The Options 
window organizes these over four tabs. 
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On the General tab, you can specify how text is formatted in the tab when more than one autotrading tool file appears in 
the Code window.  

 

On the Colors tab, you can enter settings to specify text and highlight colour in the autotrading tool file. In the Elements 
section, select the code element you want and use the Foreground and Background drop-down menus to select colours 
from a chart. If you want to change the colours back to the way they were when you first installed MetaEditor, you can 
click Reset All.  
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On the Font tab, you can specify font type, size and script settings for the text that appears in the code of the autotrading 
tool file. You can view how the text will look in the Text Preview box.  

 

On the Network tab, you can view proxy server settings, if they are entered.    
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Section 5: Using MetaTrader’s Autotrading Tools 
Most trading advisors recommend that traders follow a set trading strategy and stick to it. MetaTrader offers a variety of 
automated trading tools that may help you do just that:  

• Expert Advisors. These automated trading strategies perform real-time technical analysis of price data and manage 
trading activities based on current market conditions.  

• Custom Indicators. These modified technical indicators analyse the price moves of an instrument. 

• Scripts. These perform an automated analytic or trading function on request. Unlike expert advisors, which 
continually work and execute orders based on market moves, a script only performs a function once. 

In this section, we’ll discuss how to use each of these three automated trading tools.  

Enabling Autotrading Tools 
Before you use an expert advisor, custom indicator or script, you need to enable them in MetaTrader. You can do this on 
the Expert Advisors tab of the Options window. 

 

You can open the Options window by clicking on the Tools menu in the MetaTrader tool bar and selecting Options.  
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The Enable Expert Advisors checkbox activates all expert advisors in MetaTrader. When the checkbox is not checked, the 
expert advisors will not analyse chart price movements. The Disable… checkboxes beneath it allow MetaTrader to 
automatically deactivate all of your expert advisors if you change your account or your profile.  

The Allow Live Trading checkbox enables you to place orders when an expert advisor or script is active. When this is 
checked, you can also choose to select the Ask Manual Confirmation checkbox below it. If your expert advisor or script is 
about to perform a trade and this checkbox is selected, a notification appears, asking you to confirm the trade. 

The Allow DLL Imports checkbox allows your expert advisors, custom indicators or scripts to automatically access the 
dynamic-link library (.dll) files associated with them. When this is checked, you can also choose to select the Confirm DLL 
Function Calls checkbox below it. If your expert advisor, custom indicator or script is about to access a set of .dll files and 
this checkbox is selected, a notification appears, asking you to confirm the request. 

The Allow External Experts Imports checkbox enables your expert advisors, custom indicators or scripts to automatically 
import functions from other MQL4 files. This is a security option that protects you when you are working with expert 
advisors, custom indicators or scripts from an unknown source. 

 
If you are only using expert advisors, you can click in the Standard toolbar to activate 

them. When active, the button changes to look like this: . This button does not activate 
custom indicators or scripts. 
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Enabling Expert Advisors, Custom Indicators, Scripts or Libraries in MetaTrader: 

1. Click the Tools menu and select Options.  

2. In the Options window, click on the Expert Advisors tab.  

3. Make sure Enable Expert Advisors is selected.  

4. If you are using expert advisors or scripts, check Allow Live Trading. 

5. If you are using custom indicators or scripts, check Allow DLL Imports and Allow External Experts Imports. 

6. Change the rest of the options to suit your trading style.  

7. When done, click OK.  

 

You cannot use expert advisors, custom indicators, scripts and related files on practice accounts.   

Finding Autotrading Tools in the Online Library 
When you first open MetaTrader, you can access a few expert advisors, custom indicators and other autotrading tools from 
the Navigator window. You can also download additional autotrading tools using the Online Library in MetaEditor; this is a 
MetaTrader developer application that helps you import, create and modify expert advisors. 
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You can access the Online Library by right-clicking on the Expert Advisor, Custom Indicator or Script menu in the Navigator 
window and select Online Library. This opens MetaEditor. For an overview of this application, see Section 4: Opening 
MetaEditor for the First Time. 

The Online Library opens in the Toolbox window of Meta Editor. You can use the toolbar along the top of this window to 
switch your search between expert advisors, custom indicators, scripts and libraries. When you’re searching for expert 
advisors, make sure Experts is selected.  

 

You can use the scroll bar to move through the list. You can also click  to see if any new expert advisors have 
been added.  

When you find the expert advisor, custom indicator or script you want, select it and click . You can also 
right-click in the expert advisor row and select Download from the drop-down menu. This opens the source code of the 
autotrading tool in the MetaEditor workspace. 

If you know MQL.4 (the MetaTrader programming language), you can edit the code manually or add additional code 
components from the tools in the Navigator window. You can also open other source code files and copy and paste 
sections of code into the downloaded file.  

A star appears in the header of the source code file after you’ve edited it. You can click Save to save your changes and 
continue working. 
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If you have no changes to the downloaded file, click . This verifies if the code works as programmed. The 
Errors tab opens automatically in the Toolbox window to show you if there are any errors or warnings. When the 
compilation is successful, MetaEditor saves the file.  

 

Once compiled, you can view the expert advisor, custom indicator or script you want in the Navigator window of 

MetaTrader. To return to MetaTrader, click . 

Finding Autotrading Tools in the Online Library: 

1. Right-click on the Expert Advisor, Custom Indicator or Script menu in the Navigator window and select Online 
Library. 

2. In the Online Library tab of the Toolbox, make sure the type of autotrading tool you want is selected.   

3. Scroll through the list of available autotrading tools.  

4. When you find one, select it and click . 

5. If desired, make any changes to the code.  

6. Click .   

 

Because EAs are created by separate and independent third parties, GFT is not responsible for their 
completeness, reliability or accuracy. In other words, you use them at your own risk. If you have questions on 
how an EA works, you will need to contact the EA provider.  But, if you need help managing EAs in MetaTrader 
4, contact GFT. 

 

 

If you edited an expert advisor and if, after you compiled it, the icon is gray in the Navigator window, there is 
an error and you cannot use the expert advisor. You’ll need to review and edit your code and then compile the 
code again. 

Creating an Expert Advisor  
If you know MQL.4 (the MetaTrader programming language), you can create a new expert advisor by right-clicking on the 
Expert Advisors menu in the Navigator window and selecting Create.  
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This opens MetaEditor, an application installed with MetaTrader that helps you create expert advisors, and displays the 
Expert Advisor wizard.  

 

The Expert Advisor wizard helps you specify which type of expert advisor you want and name the file.  
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Once you click Next, the wizard opens the General Properties window. Here, you can add parameters to the file in the 
wizard by clicking Add. Once added, you can change what kind of parameter the expert advisor uses by right-clicking on it 
and selecting Change Type. This displays a drop-down menu of several strings. You can also change the initial value for the 
parameter by right-clicking on it and selecting Edit Value. If you want to change the name of the parameter, right-click on 
it and select Rename. You can also remove a parameter by selecting it and clicking Delete. 

When you click Finish, the wizard closes and opens a text file with the code for the parameters in it. You can continue to 
add code for the expert advisor. The source file (*.MQ4) is saved in the Experts folder. 

The expert advisor appears as a selection in the Navigator window of MetaEditor, under the Templates folder on your 
computer. 

Creating an Expert Advisor: 

1. In MetaTrader, right-click on the Expert Advisors menu in the Navigator window and select Create.  

2. When the Expert Advisor Wizard opens in MetaEditor, make sure Expert Advisor is selected and click Next.  

3. Enter the expert advisor name, the developer’s name and the developer’s website.  

4. If desired, click Add to add a parameter to the expert advisor. If you need to customize it, right-click on the parameter 
and select Change Type, Edit Value or Rename, as desired. 

5. Click Finish.  

6. Make the changes you want to the code file, as desired. 

7. Click . 

 

You can switch back to MetaTrader without closing MetaEditor by clicking  in the toolbar. 

Testing an Expert Advisor 
Once you create an expert advisor, you can test your own expert advisors before you attach them to a chart. You can also 
specify settings so MetaTrader can automatically optimize the expert advisor. The Strategy Tester shows you how an 
expert advisor would work on a particular instrument under one or more market conditions. You can access the Strategy 
Tester by clicking View and selecting Strategy Tester.  
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You can select the expert advisor you want to test using the Expert Advisor drop-down menu, which contains a list of all 
available expert advisors. If you want to see or modify the settings of the expert advisor before you run it, you can click the 
Expert Properties button. This displays a window with information about the expert advisor on three tabs. 

 

On the Testing tab, you can test how the expert advisor would work with your initial deposit and in the base currency you 
want. The Positions drop-down menu allows you to select if the expert advisor opens both long (buy) and short (sell) 
positions or only long or short positions.  

You can run an expert advisor through multiple tests that mimic different market conditions. This is called optimization. On 
the Testing tab, you can choose one of five models for optimization using the Optimized Parameter drop-down menu.  

• Balance reports the smallest balance value in the deposit currency. 

• Profit Factor determines the gross profit and gross loss of one trade. 

• Expected Payoff looks at the average profit/loss factor of one trade. You can use this to determine whether the trade 
was profitable or unprofitable. 

• Maximal Drawdown calculates the largest loss of one trade. 

• Drawdown Percent determines the maximal drawdown of your initial deposit. 

MetaTrader will run the expert advisor through every possible combination of the parameter. If you want MetaTrader to 
test the expert advisor using random, selective combinations, you can check the Genetic Algorithm checkbox.  
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On the Inputs tab, you can select variables that affect how the expert advisor works. The inputs that you see in this tab 
depend on the expert advisor you selected; you can use the checkboxes to select the lot size, trailing stop levels, or other 
information and double-click in the Value, Start, Step or Stop column to change the values. You can also click Load to add 
inputs to the expert advisor or Save to save the variables as a set.  

 

On the Optimization tab, you can select limiting parameters for optimization. As MetaTrader runs the expert advisor 
through subsequent tests, it stops the test when one of the parameters is met. The parameters that you see in this tab 
depend on the expert advisor you selected; you can use the checkboxes to select parameters and double-click in the Value 
column to change its value. 

 

You need to check the Optimization checkbox on the Settings tab of the Strategy Tester for these settings to 
apply to the optimization. 
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You can determine how well an expert advisor would do with a particular instrument by selecting it from the Symbol 
drop-down menu. You can view information about the spread, contract size and other details about the selected 
instrument by clicking Symbol Properties.  

You can also select a time frame, from one minute (M1) to one hour (H1) to Daily, using the Period drop-down menu.  

If you want to view this instrument with this time frame on the chart, click Open Chart.  

MetaTrader stores historical data for all symbols and time frames so you can research the price moves of an instrument 
over time or test how an expert advisor strategy would perform during a particular market event. With historical data, you 
can use the Model drop-down menu to select three modelling types for testing. 

• Every Tick tests a strategy based on the smallest available timeframe.  

• Control Points uses the last 12 bars of the current timeframe and then calculates the next possible price moves using 
fractal interpolation.   

• Open Prices Only looks at the current open, high, low and close of data on the chart. This is the fastest method to 
analyse price moves on the chart.  

When you want the expert advisor to go through optimization, you can click the Optimization checkbox.  

If you want to modify the expert advisor before you test it, you can click Modify Expert to open Meta Editor and made the 
changes you want. Once the expert advisor is compiled, you can return to MetaTrader and continue your test.  

If you think the market will behave like it did at some point in the past, you can click the Use Date checkbox and use the 
drop-down menus to specify a date. You can select any date back to January 1, 1999.  

You can watch a visualization of the expert advisor being tested or optimized by checking Visual Mode. When this is 
checked, MetaTrader displays a chart with the expert advisor and performs the test or optimization. You can use the 
playback scrollbar to adjust the playback speed or stop the playback temporarily by clicking Pause. If you checked the Use 
Date checkbox, you can click Skip Ahead and select the date you want to see.  

When you are ready to run the test, click Start. MetaTrader shows a progress bar so you can monitor the amount of time it 
takes to run the test. At any time during the test, you can click Stop to close the test.  

 

The amount of information that appears in the chart window may be different than the amount you receive 
from the History Center. For more information, see Specifying Chart and History Data Properties in Section 6: 
Customizing the Appearance and Settings in MetaTrader. 

 

When you click Skip Ahead, MetaTrader stops the visualization and continues it after the selected date. 

 

Once opened, the Strategy Tester appears below the Terminal window. You may need to adjust the size of the 
Strategy Tester window to see all of the windows you have open. 

  
 

If you want to optimize an expert advisor, you should select Control Points. 

Testing or Optimizing an Expert Advisor: 

1. Click View and select Strategy Tester.  

2. Select the expert advisor you want from the Expert Advisor drop-down menu.  

3. Click Expert Properties and specify the settings you want on the three tabs. Click OK when done.  

4. If desired, click Modify Expert and modify the expert advisor.  

5. Select an instrument from the Symbol drop-down menu.   

6. Select the time frame you want from the Period drop-down menu.  
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7. Select Every Tick, Control Point, or Open Prices Only from the Model drop-down menu. 

8. If you are optimizing, check Optimization.   

9. If desired, check Visual Mode or check Use Date and select a date range.  

10. Click Start.  

Viewing the Results of the Expert Advisor Test 
After the test has been completed, you can see the results of the test in Results, Graph, Report and Journal tabs of the 
Strategy Tester window. 

 

The Results tab displays a table that contains information about all of the trades that were executed during the test. You 
can view information across several columns.  

Type displays what kind of trade was placed (a sell, buy, etc.). 

Order shows the ticket number of trade position or pending order. 

Lots displays the number of lots that were traded.  

Price shows the price at which the instrument was bought or sold.  

S/L displays the price at which the Stop Loss order was executed. If this field is blank, it means that no stop-loss order was 
placed.  

T/P shows the price at which the Take Profit order was executed. If this field is blank, it means that no take profit order 
was placed. 

Profit displays what your profit or loss was on the transaction. This value only appears for closed positions.  

Balance shows how the trades placed would affect your account balance. The balance value is recorded only at closing of 
positions. 

You can click in the column header to sort the entries in ascending or descending order.  

 

If you right-click in the Results tab, you can view a drop-down menu with other menu options.  

You can use Copy to copy select lines in the table. You can also click Copy All to select the entire table.  

You can also save the table as an .htm file by clicking Save as Report and entering the name of the report.  
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You can use Set Date From and Set Date To fields to change the timeframe.  

 

The Graph tab displays a graph which maps your balance (with a blue line) and the number of lots (with a green line). You 
can view this information in a legend that appears in the upper left corner.   

You can double-click anywhere in the Graph tab to return to the Results tab. 

If you right-click in the Graph tab, you can view a drop-down menu with other menu options.  

You can use Copy to copy the entire graph so you can paste it in another file. You can also save the graph as a .gif file by 
clicking Save as Picture and entering the name of the file.  

 

The Report tab displays statistics about how the test was performed.  

Bars in Test displays the number of bars that appeared in the history data. 

Ticks Modeled shows the number of ticks that were used in the test.  

Modeling Quality displays the quality of ticks modelled during testing with a percentage and a colour band. A gray band 
shows if a date range was specified in the testing settings. A red band shows that modelling was not performed on a 
portion of the time frame. During that part of the test, only data of the time frame selected in the testing settings were 
used. A green band shows that modelling was performed. The shade of green becomes brighter as the modelling quality 
gets higher.  

Initial Deposit shows the amount of your initial deposit. 

Total Net Profit displays the result of all trades. In this row, you can also view the Gross Profit, or the sum of all profitable 
trades and the Gross Loss, or the sum of all unprofitable trades. Profit Factor displays a comparison of the gross profit 
and the gross loss.  

Expected Payoff looks at the average profit/loss factor of one trade. You can use this to determine whether the trade was 
profitable or unprofitable. 

Maximal Drawdown calculates the largest loss of one trade. 

Absolute Drawdown shows the largest loss is below initial deposit value. 

The Total Trades section of the report breaks down the number of trades, long or short positions and what were your 
largest consecutive profits and losses.  
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If you right-click in the Report tab, you can view a drop-down menu with other menu options. You can use Copy to copy 
the entire report. You can also save the report as an .htm file by clicking Save as Report and entering the name of the 
report.  

You can also change the appearance of the table by right-clicking in the Report tab and selecting Auto Arrange, which 
resizes the columns automatically if the Strategy Tester window size changes or Grid, which displays the lines between the 
rows and columns. 

 

If you selected Open Prices Only from the Model Type drop-down menu in the Settings tab, the Modeling 
Quality field will display an ‘n/a’ and a red band. 

 

The Journal tab displays a list of system messages about the expert advisor’s test, such as orders filled and positions 
closed. 

Whenever you test an expert advisor, MetaTrader saves the entries that appear on the Journal tab as a .log file. You can 
view this by right-clicking in the Journal tab and selecting Open from the drop-down menu. You can also select Copy to 
copy all journal entries. If you want to remove these entries, you can select Clear All Journals.  

You can also change the appearance of the journal table by right-clicking in the Journal tab and selecting Auto Arrange. 
This resizes the columns automatically if the Strategy Tester window size changes or Grid, which displays the lines 
between the rows and columns. 

 

If you clicked Optimization in the Settings tab, two additional tabs appear in the Tester window: the Optimization Results 
tab and the Optimization Graph tab.   

The Optimization Results tab displays a table that contains information about all of the trades that were executed during 
the optimization. 

Pass shows the pass number.  

Profit displays the gross profit minus the gross loss.   
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Total Trades shows the total number of open positions. 

Profit Factor displays the ratio between gross profit and gross loss in a percent. If a one appears in this row, it means that 
these values are equal. 

Expected Payoff shows the average profit/loss of one trade.  

Drawdown $ displays the largest drawdown related to the initial deposit. 

Drawdown % shows the largest drawdown related to the initial deposit in a percentage. 

Inputs displays the changeable values of inputs at each pass. 

You can click in the column header to sort the entries in ascending or descending order.  

If you right-click in the Optimization Results tab, you can view a drop-down menu with other menu options. You can use 
Copy to copy select lines in the table. You can also click Copy All to select the entire table. You can also save the table as 
an .htm file by clicking Save as Report and entering the name of the report.  

If you want to rerun the results of the test again, click Set Input Parameters to return to the Settings tab. 

If you only want to view the results of profitable passes, you can check Skip Useless Results. You can also display or hide 
the Inputs column by checking (or unchecking) Show Input Parameters.  

You can also change the appearance of the journal table by right-clicking in the Optimization Results tab and selecting 
Auto Arrange, which resizes the columns automatically if the Strategy Tester window size changes or Grid, which displays 
the lines between the rows and columns. 

 

The Optimization Graph tab displays a graph which maps your profitable trades (in a green line) and your unprofitable 
trades (in a red line).   

You can double-click anywhere in the Optimization Graph tab to return to the Optimization Results tab. 

If you right-click in the Optimization Graph tab, you can view a drop-down menu with other menu options.  

You can use Copy to copy the entire graph. You can also save the graph as a .gif file by clicking Save as Picture and 
entering the name of the file. 

Attaching an Expert Advisor to a Chart 
Once you have the expert advisor as you want, you display it in the chart window by clicking and dragging it from the 
Navigator window. This opens a window so you can specify settings for the expert advisor. 

 

If you are using an EA and do not have a Virtual Private Server subscription, your EAs will stop running when 
you log out of MetaTrader. 
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On the Common tab, you can specify how you want the expert advisor to perform. The Positions drop-down menu allows 
you to select if the expert advisor opens both long (buy) and short (sell) positions or only long or short positions.  

You can click the Enable Alerts checkbox so that MetaTrader sends you a message when the expert advisor has placed a 
trade. You can also click Disable Alerts Once Hit so MetaTrader only sends a notification once.  

In the Live Trading section, you can click Allow Live Trading to enable or disable the expert advisor in live trading. You 
can also click Ask Manual Confirmation to have MetaTrader send you a notification when the expert advisor opens a 
position.   

The Safety section contains options for specifying how to handle dynamic-link library (.dll) files. While you may have 
already specified how MetaTrader handles these for all expert advisors, custom indicators and scripts in the Options 
window, you can specify individual settings for the selected expert advisor here. When checked, the Allow DLL Imports 
checkbox allows your expert advisor to automatically access dynamic-link library (.dll) files associated with them. When 
this is checked, you can also choose to select the Confirm DLL Function Calls checkbox below it. If your expert advisor is 
about to access a set of .dll files and this checkbox is selected, a notification appears, asking you to confirm the request. 

The Allow External Experts Imports checkbox enables your expert advisor to automatically import functions from other 
MQL4 files. This is a security option that protects you when you are working with an expert advisor from an unknown 
source. 



  MetaTrader 4 and MetaEditor User Manual 

 

93 

 

On the Inputs tab, you can view the variables used to calculate the expert advisor. The variables are specific to the expert 
advisor you selected. You can change the variable values by double-clicking in the variable row. You can also click Load to 
add inputs to the expert advisor or Save to save the variables as a set. 

If you need to return to the original settings, click Reset.  

You can verify if the expert advisor has been attached to the chart by looking for one of three types of icons in the upper 
right corner of the chart. A  means that the expert advisor was attached and is actively trading. A  shows that the 
expert advisor was attached, but that live trading is disabled for it. A means that all expert advisors have been disabled. 

 

Remember, the Expert Advisors button in the Standard toolbar must be active in order for your expert 
advisor to work. 

Attaching an Expert Advisor to a Chart: 

1. Right-click on the Expert Advisors you want in the Navigator window and select Attach to a Chart. 

2. Select the options you want on the Common tab.  

3. If desired, click on the Inputs tab. Click Load. Navigate to the external set you want and click Open. 

4. Click OK.  
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You can only click and drag tested expert advisors in the chart window. 

 

Only one expert can be attached to a chart. If you attach an expert advisor to a chart that already has one, the 
new expert advisor will be added and the old one removed from the chart. 

Modifying an Expert Advisor Attached to a Chart 
If you want to make a change to an expert advisor once it’s already attached to a chart, you can right-click in the chart, 
select Expert Advisors and click Properties in the drop-down menu. This opens a window so you can specify settings for 
the expert advisor. 

 

Modifying an Expert Advisor Attached to a Chart: 

1. In the chart, right-click and select Expert Advisors.  

2. From the drop-down menu, click Properties.  

3.  Make your changes as desired.  

4. Click OK.  

Removing an Expert Advisor from the Chart 
You can remove expert advisors from the chart using several methods. An expert advisor stops working when you close 
the chart attached to it or close the MetaTrader application. You can also right-click in the chart and select Remove from 
the drop-down menu.  
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Removing an Expert Advisor from the Chart: 

1. In the chart, right-click and select Expert Advisors.  

2. From the drop-down menu, click Remove.  

 

No confirmation appears when you remove an expert advisor from the window. 

Creating a Custom Indicator 
You can create a new custom indicator by right-clicking on the Custom Indicators menu in the Navigator window and 
selecting Create.  

 

This opens MetaEditor, an application installed with MetaTrader that develops autotrading tools, and displays the Expert 
Advisor wizard. 
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The wizard helps you specify which type of custom indicator you want and name the file.  

 

Once you click Next, the wizard opens the General Properties window. Here, you can add parameters to the file in the 
wizard by clicking Add. Once added, you can change what kind of parameter the custom indicator uses by right-clicking 
on it and selecting Change Type. This displays a drop-down menu of several strings. You can also change the initial value 
for the parameter by right-clicking on it and selecting Edit Value. If you want to change the name of the parameter, right-
click on it and select Rename. You can also remove a parameter by selecting it and clicking Delete. 
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When you click Next again, you can view the Drawing Properties window. Here, you can use the wizard to specify where 
the custom indicator appears. Your custom indicator will automatically appear in the chart unless you check Indicator in 
Separate Window, which displays the custom indicator in a window below the chart. You can then specify the range it will 
have by checking Minimum and Maximum and entering in a value.  

You can specify how you want the indicator to look in the chart by clicking Add in the Indexes section. You can right-click 
the Type field and select Change Type to specify if the indicator appears as a line, section, histogram or arrow. You can 
also right-click the Color field and select Change Color to specify what colour you want the indicator to be. If you make a 
mistake, you can also remove an index by selecting it and clicking Delete. 

When you click Finish, the wizard closes and opens a text file with the code for the parameters in it. You can continue to 
add code for the custom indicator. The source file (*.MQ4) is saved in the Indicators folder in the Navigator window of 
MetaEditor.   

Creating a Custom Indicator: 

1. In MetaTrader, right-click on the Custom Indicators menu in the Navigator window and select Create.  

2. When the Expert Advisor Wizard opens in MetaEditor, make sure Custom Indicator is selected and click Next.  

3. Enter the custom indicator name, the developer’s name and the developer’s website.  

4. If desired, click Add to add a parameter to the custom indicator. If you need to customize it, right-click on the 
parameter and select Change Type, Edit Value or Rename, as desired. 

5. Click Next.  

6. If desired, check Indicator in Separate Window. Then, check Minimum and Maximum and enter in a value. 

7. If desired, click Add in the Indexes section. Then right-click the Type field and select Change Type to choose the type 
you want from a drop-down menu. You can also right-click the Color field and select Change Color to select a colour.  

8. Click Finish.  

9. Make the changes you want to the code file, as desired. 

10. Click . 

 

Once compiled, you can view the custom indicator in the Custom Indicators list in the Navigator window of 

MetaTrader. You can switch back to MetaTrader by clicking  in the MetaEditor toolbar. 
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Adding a Custom Indicator to the Chart 
Once you’ve imported, created or modified the custom indicator as you want, you can display it in the chart window by 
clicking and dragging it from the Navigator window. This opens a window so you can specify settings for the custom 
indicator.  

 

On the Common tab, you can specify how this custom indicator will handle dynamic-link library (.dll) files. While you may 
have already specified how MetaTrader handles these for all expert advisors, custom indicators and scripts, you can specify 
individual settings for the selected custom indicator here. When checked, the Allow DLL Imports checkbox allows your 
custom indicator to automatically access dynamic-link library (.dll) files associated with them. The Allow Import of 
External Experts checkbox enables your custom indicator to automatically import functions from other MQL4 files. This is 
a security option that protects you when you are working with a custom indicator from an unknown source. 

 

On the Inputs tab, you can view the variables used to calculate the custom indicator. The variables are specific to the 
custom indicator you selected. You can change the variable values by double-clicking in the variable row.  
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On the Colors tab, you can modify the line colour of the custom indicator by double-clicking on the colour and selecting a 
new one from the drop-down menu. You can also specify line width on a scale of one to five by double-clicking on the 
Width row and selecting a new one from the drop-down menu that appears. If you select a line width of one, you can also 
specify whether the line appears as solid or dotted by double-clicking on the Style row and selecting a new one from the 
drop-down menu that appears. 

If your custom indicator appears outside of the chart, you will see a Levels tab. You can use this to add a horizontal line at a 
particular level in the indicator. Click Add to add a horizontal line and use the Style drop-down menus to specify a colour, 
line style and line thickness. You can add one or more lines to the indicator window. To remove lines, select a line and click 
Delete. 

 

On the Visualization tab, you can select in which time frames the custom indicator can be used. When you first open 
MetaTrader, the All Time frames checkbox is selected. When you uncheck it, you can select one or more time frames.  

If you need to return to the original settings, click Reset. 

Adding a Custom Indicator to a Chart: 

1. Right-click on the custom indicator you want in the Navigator window and select Attach to a Chart. 

2. Select the options you want on the Common tab.  

3. If desired, click on the Inputs tab. Click Load. Navigate to the external set you want and click Open. 

4. Adjust the settings as desired in the other tabs.  

5. When done, click OK.  

 

You can duplicate custom indicators and use the settings on the Visualization tab to specify different time 
frames for each one. You can then place these in the same chart and compare how the indicator for the 
instrument would behave over multiple time frames. 

Modifying a Custom Indicator Attached to a Chart 
Once a custom indicator is attached to a chart, you can modify it using the Indicators List. This displays a list of all 
indicators in the chart window. 



  MetaTrader 4 and MetaEditor User Manual 

 

100 

 

Modifying a Custom Indicator Attached to a Chart: 

1. In the chart, right-click and select Indicators List.  

2. Make sure the custom indicator you want is selected and click Edit. 

3.  Make your changes as desired.  

4. Click OK.  

5. If you need to edit another custom indicator, select it, click Edit, and repeat the steps above.  

6. When done, click Close.  

 

You can also remove custom indicators from the chart using the Indicators List. In the Indicators window, 
select the indicator you want to remove and click Delete.   

Creating a Script 
You can create a new script by right-clicking on the Scripts menu in the Navigator window and selecting 
Create.  
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This opens MetaEditor, an application installed with MetaTrader that develops autotrading tools, and 
displays the Expert Advisor wizard. 

 
The wizard helps you specify which type of script you want and name the file.  
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When you click Finish, the wizard closes and opens a text file so you can view and edit the code. You can continue to add 
code for the script. You can view the file in the Scripts menu of the Navigator window in MetaTrader. 

Creating a Script: 

1. In MetaTrader, right-click on the Scripts menu in the Navigator window and select Create.  

2. When the Expert Advisor Wizard opens in MetaEditor, make sure Script is selected and click Next.  

3. Enter the script name, the developer’s name and the developer’s website.  

4. Click Finish.  

5. Make the changes you want to the code file, as desired. 

6. Click . 

 

Once compiled, you can view the script in the Scripts list in the Navigator window of MetaTrader. You can 

switch back to MetaTrader by clicking  in the MetaEditor toolbar. 

Executing a Script on the Chart 
Once you’ve imported, created or modified the script as you want, you can display it in the chart window by clicking and 
dragging it from the Navigator window. Depending on what the script does, MetaTrader will either see a confirmation or 
view a settings window so you can customize the script. 
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If your script is designed to execute a command based on certain conditions, you will see a confirmation window. After 
you click Yes, you may see the settings window, depending on the type of script. 

If the settings window appears, you can specify how you want the script to perform on the Common tab. While you may 
have already specified how MetaTrader handles permissions for all expert advisors, custom indicators and scripts, you can 
specify individual settings for the script here. The Positions drop-down menu allows you to select if the script opens both 
long (buy) and short (sell) positions or only long or short positions.  

You can click the Enable Alerts checkbox so that MetaTrader sends you a message when the script has placed a trade. You 
can also click Disable Alerts Once Hit so MetaTrader only sends a notification once.  

In the Live Trading section, you can click Allow Live Trading to enable or disable the script in live trading. When this is 
checked, you can also choose to select the Ask Manual Confirmation checkbox below it. If your script is about to perform 
a trade and this checkbox is selected, a notification appears, asking you to confirm the trade. 

The Safety section contains options for specifying how to handle dynamic-link library (.dll) files. When checked, the Allow 
DLL Imports checkbox allows a script to automatically access .dll files associated with them. When this is checked, you can 
also choose to select the Confirm DLL Function Calls checkbox below it. If your script is about to access a set of .dll files 
and this checkbox is selected, a notification appears, asking you to confirm the request. 

The Allow Import of External Experts checkbox enables your script to automatically import functions from other MQL4 
files. This is a security option that protects you when you are working with a script from an unknown source.  
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On the Inputs tab, you can view the variables used to calculate the script. The variables are specific to the script you 
selected. You can change the variable values by double-clicking in the Value column of the variable row.  

 

If you need to return to the original settings, click Reset.  

Executing a Script on the Chart: 

1. Right-click on the script you want in the Navigator window and select Executing a Script on the Chart. 

2. If the confirmation window appears, click Yes to confirm the settings. If the settings window appears, select the 
options you want on the Common tab.  

3. If desired, click on the Inputs tab. You can click Load to navigate to the external set you want and click Open. 

4. Click OK.  

 

Only one script can be attached to a chart at a time. When a chart already has an attached script, a 
confirmation window appears, verifying that the new script will be added and the old one removed from the 
chart.   

Removing a Script Attached to a Chart 
Unlike expert advisors, which continually work and execute orders based on market moves, a script only performs a 
function once. Normally, a script shuts down by itself, but there are several ways that you can remove it.  
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The script will be removed from the chart if you: 

• Exit MetaTrader. 

• Change the instrument or time frame.  

• Click on a script in the Navigator window and drag it to the chart.  

• Right-click in the chart and select Remove Script. 

Modifying an Expert Advisor, Custom Indicator or Script 
Once added to the Navigator window, you can edit an expert advisor, custom indicator or script before you add it to the 
chart if you know MQL.4. Right-click on the autotrading tool in the Navigator window and select Modify from the drop-
down menu. This opens MetaEditor and displays the source code of the file.  

Modifying an Expert Advisor, Custom Indicator or Script: 

1. Right-click on the autotrading tool you want in the Navigator window and select Modify. 

2. In MetaEditor, make the changes you want to the code file, as desired.  

3. Click Save.  

4. Click .  
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MetaEditor is an application installed with MetaTrader that enables traders to import, create and modify 
expert advisors, custom indicators, scripts and other autotrading tools. See Section 4: Opening MetaEditor 
for the First Time for more information. 

Deleting an Expert Advisor, Custom Indicator or Script from the 
Navigator 
If you make a mistake or change your mind after you add an expert advisor, custom indicator or script to the Navigator 
window, you can permanently remove it from MetaTrader. 

 

Deleting an Expert Advisor from the Navigator: 

1. Right-click on the expert advisor, custom indicator or script you want in the Navigator window and select Delete. 

2. Click Yes to confirm. 

 

If an expert advisor, custom indicator or script is attached to a chart, deleting it from the Navigator window 
does not stop it from performing autotrading. You need to remove it from the chart. 



  MetaTrader 4 and MetaEditor User Manual 

 

107 

Adding a Library to an Expert Advisor or Script 
As you create expert advisors or scripts, you may want to add a dynamic-link library (.dll) to the file. You can download or 
create one in MetaEditor, an application installed with MetaTrader that develops autotrading tools.  

 

You can either download .dll files from the MetaEditor Online Library or create one using the tools in MetaEditor. To access 

MetaEditor from MetaTrader, click the MetaEditor  button in the Standard toolbar.  
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To download a library, make sure the Online Library tab is open in the Toolbox window and that Libraries is selected.  

You can use the scroll bar to move through the list. You can also click  to see if any new library files have been 
added.  

When you find the library file you want, select it and click . You can also right-click in the library row and 
select Download from the drop-down menu. This opens the library source code file in the workspace. 

 

To create a new library from scratch, click New in the File menu. This opens the Expert Advisor window. Make sure Library 
is selected.  

Once you click Next, the wizard opens the General Properties window. When you click Finish, the wizard closes and opens 
a text file with the code for the parameters in it. 

You can edit the code manually or add additional components from the tools in the Navigator window. You can also open 
other source code files and copy and paste sections of code into the downloaded file.  
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A star appears in the header of the library source code file after you’ve edited it. You can click Save to save your 
changes and continue working. 

Once your edits are made, click . This verifies if the code works as programmed. The Errors tab opens 
automatically in the Toolbox window to show you if there are any errors or warnings. When the compilation is successful, 
MetaEditor saves the file. 

 

See Section 4: Opening MetaEditor for the First Time for more information on MetaEditor. 

Setting Keyboard Shortcuts for Autotrading Tools in the Navigator 
Window 
If you think you will use an expert advisor, custom indicator or script frequently, you can set a keyboard shortcut or hot 
key to open the autotrading tool automatically in the chart.  

 

When you right-click on one of these items in the Navigator window, you can select Set Hotkey. This opens the Navigator 
Hot Key window, where you can select an item from the list and set a keystroke combination. 

If you make a mistake, you can click Reset to remove the hot key from the selected indicator, expert advisor, custom 
indicator or script. To remove all of the hot keys from these items, click Reset All.  
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Setting Keyboard Shortcuts in the Navigator Window: 

1.  In the Navigator window, right-click on a specific indicator, expert advisor, custom indicator or script and select Set 
Hotkey. 

2. In the Navigator Hot Key window, make sure the item you want is selected. If not, scroll to it.   

3. Click Set.  

4. Use the drop-down menu in the Control column to select either ALT or CTRL.  

5. Enter the keyboard button in the Key column.  

6. Click Close. 

 

MetaTrader already has a number of commands set as hot keys. For a full list, see Appendix A: MetaTrader 
Hot Keys. If you accidentally set an indicator, expert advisor, custom indicator or script to a hot key that’s 
already used by the system, click Reset and change the hot key to another combination. 
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Section 6: Customizing the Appearance and Settings in 
MetaTrader 
As you become more familiar with MetaTrader, you may want to change some of the settings to make the platform fit your 
trading style. In this section, we’ll look at ways to customize windows and other tools in MetaTrader. 

Changing the Language in MetaTrader 
You can select the language you want the functionality of MetaTrader to appear in by clicking the View menu and 
selecting Languages. You can then select the language you want from the drop-down menu. 

 

You will need to restart MetaTrader for the language change to take effect. When you re-login, MetaTrader will display its 
windows in the language you specified. 

Customizing the Toolbars 
You can modify the options that appear in the four toolbars in MetaTrader by right-clicking on the toolbar and selecting 
Customize… from the drop-down menu. This displays the Customizing Toolbar window for that specific toolbar.  
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This window is where you can specify what appears in the selected toolbar. The Available section shows any menu options 
that are currently not in the toolbar and can be added. The Selected section displays all of the options that are currently 
displayed in the toolbar.  

The tools that appear in the Available and Selected section depend on which toolbar you right-clicked on.  

To place a tool on the toolbar, you can select it in the Available section and click Insert. Conversely, you can remove a tool 
from the toolbar by clicking it in the Selected section and then selecting Remove.  

You can also reposition the order of the tools in the menu bar by selecting a tool and clicking Up or Down.  

If you need to return to your original settings, click Reset.  

When you are done reordering the toolbars, click Close.  

Customizing the Appearance of the Chart Window 
You can change the setup of the chart window by right-clicking in the chart and selecting Properties from the drop-down 
menu. This opens the Chart Properties window. 
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This window organizes the various settings for the selected chart window on two tabs: the Colors tab and the Common 
tab.  

If you make a mistake while entering settings, you can click Reset to restore all of your settings to the original ones.  

When you are done customizing the settings, click OK.  

Changing the Colour of the Chart Window  
On the Colors tab, you can specify the colours for the chart window background, foreground and grid. You can also select 
colours for the bars, candles, line graph and other features.  

 

You can use the Color Scheme drop-down menu to select a set of pre-defined colour properties. You can choose from 
three types of commonly used colour schemes.  
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To select a colour, click on the drop-down icon for the setting you want to change and select a colour from the Color 
Selection menu.  

 

If you don’t see a colour you want to add, click Custom at the bottom of the Color Selection menu. This displays the Color 
window. You can enter a colour code or use the colour view to click and drag to mix the colour you want. When you have 
the colour you want, click Add to Custom Colors. You can add up to 16 custom colours. When you are done, click OK.  

 

Customizing Viewing Settings on the Chart Window 
On the Common tab, you can also specify settings. Some of these may already be selected based on what you chose in the 
Charts toolbar.  
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The Offline Chart checkbox turns the chart offline; when checked, the chart window stops receiving and drawing price 
data. The Offline Chart checkbox will be checked if you click the File menu and select Open Offline.  

The Chart on Foreground checkbox places the chart in the foreground. When this is checked, all drawing objects will look 
as if they are under the price chart. The Chart on Foreground checkbox will be checked if you click the Charts menu and 
select Foreground Chart.  

The Chart Shift checkbox arranges the chart so the latest price moves appear at a certain point in the chart. When active, 
you can click the marker at the top of the chart window and set it anywhere between the right side of the chart and the 
middle of the chart. The Chart Shift checkbox will be checked if you click the Charts menu and select Chart Shift. 

The AutoScroll checkbox updates the chart so that it always scrolls to the right to show the latest price moves. The 
AutoScroll checkbox will be checked if you click the Charts menu and select AutoScroll. 

The Scale Fix One to One checkbox sets the chart scale as "one to one”; the size of one point of the vertical axis in pixels 
is equal to the distance between the bars axes in pixels. When placing lines and other drawing objects or indicators on the 
chart, many traders prefer to set Scale Fix One to One because it creates the most accurate objects or indicators.  

 

The Scale Fix checkbox sets the current chart scale to a value that you specify in the Fixed Maximum and Fixed 
Minimum text box.  

When selected, the Bar Chart radio button displays the price moves of the selected instrument as a sequence of bars. 

When selected, the Candlestick Chart radio button displays the price moves of the selected instrument as a sequence of 
blocks or candles. Each candle displays the high, low, open and close of the instrument and represents the trading activity 
for the time frame selected in the chart.  

When selected, the Line Chart radio button displays the price moves of the selected instrument as a continuous line. The 
line connects the close prices for the time frame selected in the chart. 
The Show OHLC checkbox displays or hides price information that appears in the upper left corner of the chart window. 
You can view the open, high, low and close of the latest bar, candle or line on the screen.   



  MetaTrader 4 and MetaEditor User Manual 

 

116 

The Show Ask Line checkbox displays or hides a horizontal line on the chart that tracks the ask price of the last quote. In 
MetaTrader, the price moves that you see on the chart track the bid prices of the selected instrument, but when you open a 
long position or close a short position, the ask price is always used. This line shows traders what the ask price is.  

The Show Period Separators checkbox displays or hides vertical lines in the chart to mark periods of time, depending on 
the time frame. For example, if the Periodicity drop-down menu in the chart window is set between M1 and H1, 
MetaTrader will draw vertical lines to separate the days. If Periodicity is set to H4, the period separators represent weeks; 
for D1, the period separators depict months and, for W1 and MN1, they represent years. 

The Show Grid checkbox displays or hides vertical and horizontal grid lines in the chart window. The Show Grid checkbox 
will be checked if you click the Charts menu and select Grid. 

The Show Volumes checkbox displays or hides the current trading volume for the selected instrument in the chart 
window. The Show Volumes checkbox will be checked if you click the Charts menu and select Volumes. 

The Show Object Descriptions checkbox displays or hides the description of objects in the chart window. If this option is 
enabled and there are descriptions of objects imposed into the chart available, they will be shown directly in the chart. 

Specifying MetaTrader User Settings 
You can customize MetaTrader features and tools using the Options window. You can open this by clicking on the Tools 
menu and selecting Options.  

 

The Options window organizes the various settings for MetaTrader on several tabs. In this topic, you’ll see how to specify 
features on each tab.  

Viewing MetaTrader Server Settings 
The Server tab in the Options window displays the settings that specify how MetaTrader connects to the GFT servers.  
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The Server drop-down menu enables you to select one or more servers. This should already be set with the server IP 
address and port number you need.  

The Login and Password text boxes are where your login information is stored. If you need to change your password, click 
Change. This opens the Change Password window, where you can enter and confirm your new password.   

If your version of MetaTrader is set up to use a data centre, make sure the Data Center Auto Configuration checkbox is 
selected.  

The Keep Personal Settings and Data at Startup checkbox stores personal information and other data about your 
trading. If you are using MetaTrader on a shared computer, you can clear your login information by unchecking this 
checkbox. 

The Enable DDE Server checkbox displays whether expert advisors and other tools in MetaTrader can use the Dynamic 
Data Exchange (DDE), a tool on Microsoft Windows operating systems that allows your computer to exchange information 
with other applications.  

The Enable News checkbox displays whether MetaTrader can import news, messages and other information from the 
server.  

 

Usually, the information that appears on the Server tab is first entered when MetaTrader is installed and you 
do not need to change it. If you believe you need to change it, contact GFT Technical Support. 

Specifying Chart and History Data Properties 
The Charts tab in the Options window displays the settings for the chart windows and history data.  
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The Show Trade Levels checkbox displays or hides a horizontal line on the chart that shows where a position was opened 
or where a Stop Loss or Take Profit order will occur.  

The Show OHLC checkbox displays or hides price information that appears in the upper left corner of the chart window. 
You can view the open, high, low and close of the latest bar, candle or line on the screen. 

The Show Ask Line checkbox displays or hides a horizontal line on the chart that tracks the ask price of the last quote. In 
MetaTrader, the price moves that you see on the chart track the bid prices of the selected instrument, but when you open a 
long position or close a short position, the ask price is always used. This line shows traders what the ask price is. 

The Show Period Separators checkbox displays or hides vertical lines in the chart to mark periods of time, depending on 
the time frame. For example, if the Periodicity drop-down menu in the chart window is set between M1 and H1, 
MetaTrader will draw vertical lines to separate the days. If Periodicity is set to H4, the period separators represent weeks; 
for D1, the period separators depict months and, for W1 and MN1, they represent years. 

The Color Print checkbox allows you to print all charts in colour when enabled. If unchecked, the charts appear in black 
and white.   

The Save Deleted Charts to Reopen checkbox saves the settings from charts that were deleted or closed. When enabled, 
any chart can be restored when you click the File menu and select Open Deleted. 

The Max Bars in History drop-down menu allows you to specify how many bars, candles or line ticks are saved with the 
chart history. When you open a chart history, MetaTrader will display only the amount of bars, candles or line ticks as 
specified in the drop-down menu. 

The Max Bars in Chart drop-down menu allows you to specify how many bars, candles or line ticks appear in the chart. 
When you open a chart, MetaTrader will display only the amount of bars, candles or line ticks as specified here. If the chart 
is set to display the latest price information or is refreshed after being in offline mode, MetaTrader will discard older bars, 
candles or line ticks as specified in the drop-down menu. 

 

The settings you specify here will be used whenever you open a new chart window. If you change any settings 
on this tab, it will not affect individual chart settings you may have already specified on the Common tab of 
the Chart Properties windows. 

Customizing Object Properties on the Chart 
The Objects tab in the Options window displays the settings for objects, such as line studies, technical indicators and 
drawing items, that appear in the chart window. 
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The Show Properties After Creation checkbox displays the edit window immediately after you draw an object. That way, 
you can specify settings for the object. When not checked, MetaTrader configures your drawings with the current settings.  

The Select Objects after Creation checkbox allows you to specify if you want the object you’ve just drawn to appear in 
the chart window. When not checked, the last selected item remains active.  

The Select Objects by a Single Mouse Click checkbox allows you to click once on an object to select it. When not 
checked, you need to double click on an object to select it.  

The Magnet Sensitivity drop-down menu automatically places objects that you’ve drawn a certain number of pixels from 
an open, close, high or low price point on the chart. For example, if you select 10, the object on the chart will automatically 
be anchored within 10 pixels of the nearest open, close, high or low price point on the chart. You can disable this option by 
selecting zero from the drop-down menu. 

Specifying Order Settings  
The Trade tab in the Options window displays the settings for opening orders in MetaTrader.  

 

The Symbol by Default section specifies which instrument to use when you open the New Order window to place a 
market order. When Automatic is selected, the first instrument in the instrument list is selected in the Symbol drop-down 
menu of the New Order window. When Last Used is selected, the last instrument you traded is selected. When Default is 
selected, you can use the drop-down menu beside it to select a specific instrument.   
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The Size by Default section sets the lot size of the trade you want to fill. The number of lots you entered in your last trade 
is used indefinitely when Last Used is selected. If you want to trade using a constant number of lots, you can select 
Default and use the drop-down menu beside it to set the lot size.   

The Deviation by Default section specifies the number of pips that the price can change when you place an order. If 
markets are fast moving or become extremely volatile, such as during a news announcement, the price of the market that 
you’re trying to trade may suddenly jump or drop in a moment. If this should occur, MetaTrader 4 fills your order, but at 
the nearest market price; this may be a multiple pips away from the original price. This is called slippage. In this section, 
you can click Default and specify that MetaTrader fill your order as long as the price is within the number of pips above or 
below the price at which you placed the order. If you select Last Used, MetaTrader uses the number of pips at which the 
last order was placed, if there is slippage.  

Customizing Autotrading Settings  
The Expert Advisors tab in the Options window displays settings that specify how MetaTrader uses expert advisors, custom 
indicators, scripts or libraries. 

 

Enable Expert Advisors activates (or deactivates) all expert advisors in MetaTrader. When the checkbox is not checked, 
the expert advisors will not analyse chart price movements. The Disable… checkboxes beneath it allows MetaTrader to 
automatically deactivate all of your expert advisors if you change your account or your profile.  

Allow Live Trading enables you to place orders when an expert advisor or script is active. When this is checked, you can 
also choose to select the Ask Manual Confirmation checkbox below it. If your expert advisor or script is about to perform 
a trade and this checkbox is selected, a notification appears, asking you to confirm the trade. 

Allow DLL Imports allows your expert advisors, custom indicators or scripts to automatically access dynamic-link library 
(.dll) files associated with them. When this is checked, you can also choose to select the Confirm DLL Function Calls 
checkbox below it. If your expert advisor, custom indicator or script is about to access a set of .dll files and this checkbox is 
selected, a notification appears, asking you to confirm the request. 

Allow External Experts Imports enables your expert advisors, custom indicators or scripts to automatically import 
functions from other MQL4 files. This is a security option that protects you when you are working with expert advisors, 
custom indicators or scripts from an unknown source. 

Entering Email and Server Settings 
The Email tab is where you can enter your email and server information.  
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To begin entering information, click Enable.  

The SMTP Server text box is where you will enter the address of your SMTP server and the port number.  

The SMTP Login text box and SMTP Password text box are where you enter the login and password for the trader server.  

The From text box is where you enter your name and the email address on the SMTP; this is the address from which the 
message will be sent.  

The To text box is where you enter the name and email address that you want to send the message to.  

The Test button sends a message using the settings specified. If the test is successful, click OK. If not, check the settings 
and test again.  
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Entering Reporting Settings 
The Publisher tab is where you can publish reports about your account status to the internet automatically.  

 

To begin entering information, click Enable. 

The Account text box is where you’ll enter the account number that you want published.  

The Refresh Every drop-down menu allows you to specify how often MetaTrader sends a report to the server. You can 
select time frames from five minutes to 1440 minutes.  

The FTP Server text box is where you’ll enter the FTP server address where the report will be sent. 

The FTP Path text box is where you’ll enter the name of the FTP server directory where the report will be placed. You’ll 
need to include the path, including the root directory, in this field.  

The FTP Login text box and FTP Password text box are where you enter the login and password for the FTP server.  

When Enable is selected, the Passive Mode checkbox becomes active. In active mode, the server sets up a connection 
with MetaTrader to transfer data. In passive mode, MetaTrader establishes a connection with the server.  

The Test button posts a report to the server using the settings specified. If the test is successful, click OK. If not, check the 
settings and test again.  

 

MetaTrader will only publish reports for active accounts. If the account number entered does not match with 
the one on file, MetaTrader will not publish the report. 

Customizing Sounds for MetaTrader 
The Events tab displays a list of MetaTrader actions that play a sound file when active. 
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To begin entering information, click Enable. 

You can double-click in the Event column to turn on or off a sound.  means an alarm will sound.  means the alarm 
was turned off.  

In the Action column, you can double-click to display a drop-down menu of possible sounds. Simply click on the new .wav 
file to select the sound.  

If you have other sound files on your computer, you can double-click in the Action column and select Choose Other… from 
the drop-down menu. This opens the Open window and you can navigate to the folder where your sound files are stored. 
When you find one, click on it and select Open.  

If you want to use sounds, you should choose a different sound file for each event. You can view what each event does in 
the list below:  

Connect signals that MetaTrader has successfully connected to the server.  

Disconnect indicates that the connection to the server has been lost.   

Email Notify signals that a new email has been received in the MetaTrader mailbox. You can view it on the Mailbox tab of 
the Terminal window.  

Timeout indicates that the time range for performing a specific trade operation has ended. For instance, you might hear 
this sound if you place an order in an extremely volatile market and your order was not placed.  

OK signals that the trade operation you just executed was successfully performed.  

News indicates that MetaTrader has received a new news story. You can view it in the News tab of the Terminal window. 

Expert Advisor signals that an expert advisor has performed a trade operation.  

Expert Confirmation indicates that a manual confirmation is open and needs your confirmation. When the Ask Manual 
Confirmation is selected in the Expert Advisors tab, MetaTrader displays a notification, asking you to confirm the trade 
when your expert advisor or script is about to perform a trade. 

Alert signals that market conditions have hit the alert you specified with your expert advisor.  

Requote indicates that the price of the instrument you placed the order for changed in the middle of the trade operation.  

Trailing Stop signals that one of your trailing stop orders has been triggered.    
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Accessing the History Center 
MetaTrader stores historical data for all symbols and time frames in its server. If you need to research the price moves of 
an instrument over time or want to test how an expert advisor strategy would perform on a particular event, you can 
access this historical data by clicking the Tools menu in the menu bar and selecting History Center.  

 

You can download quotes for instruments from 1999 to present by selecting the instrument and the timeframe you want 
from the list and clicking Download.  

 

If you need to add a time point, you can click Add. This opens the Bar window, where you can enter the time and modify 
the open, high, low or close.  

You can also modify a time point by selecting a time point and clicking Edit or remove a time point by selecting a time 
point and clicking Delete. 

 

Data that appears in the History Center is downloaded from MetaQuotes servers, even though your account is 
available through GFT. Data that appears in the History Center can vary from the historical information stored 
on GFT’s trade server. 
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Because the chart history is stored on the server, it may take MetaTrader a few moments to generate the 
historical data. 

You can save data from the History Center as an external .csv, .prn or .htm file by clicking Export. This opens the Save As 
window. Here, you can navigate to the folder you want, select a file type, add a file name and click Save.  

 

If you already have historical chart data from another source, you can click Import. This displays the import window. Here, 
you can select a.csv, .prn, .txt, .htm or .hst file by clicking Browse and navigating to the file.  

Once selected, you can use:  

• The Separator drop-down menu to specify what kind of separator to use. You can select either a comma, semicolon, 
space or tab.  

• The Skip drop-down menus to select how many columns or rows MetaTrader should use when importing.  

• The Shift drop-down menu if you need to shift data by several hours in time.   

• The Selected Only checkbox to import only data that is selected in the history. You can select data by clicking and 
pressing CTRL or SHIFT. 

• The Volumes checkbox to enable or disable MetaTrader’s ability to import volume.  

 

When importing a file, the historical data should be written as follows (another separator can be used instead 
of a space): 

• YYYY.MM.DD HH:MM O H L C V 

• YYYY-MM-DD HH:MM O H L C V 

• YYYY/MM/DD HH:MM O H L C V 

• DD.MM.YYYY HH:MM O H L C V 

• DD-MM-YYYY HH:MM O H L C V 

• DD/MM/YYYY HH:MM O H L C V 
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.hst files should also include both the following header: 

struct HistoryHeader 
{ 
  int     version;       // database version 
  char    copyright[64]; // copyright info 
  char    symbol[12];    // symbol name 
  int     period;        // symbol timeframe 
  int     digits;        // the amount of digits after decimal point in the symbol 
  time_t  timesign;      // timesign of the database creation 
  time_t  last_sync;     // the last synchronization time 
  int     unused[13];    // to be used in future 

}; 

And the following bars array (with single-byte justification) 
#pragma pack(push,1) 
//---- standard representation of the quote in the database 
struct RateInfo 
{ 
  time_t            ctm;                // current time in seconds 
  double            open; 
  double            low; 
  double            high; 
  double            close; 
  double            vol; 
}; 
#pragma pack(pop) 

Exporting Quotes 
You can export current quotes to other programs using the Dynamic Data Exchange (DDE), a tool on Microsoft Windows 
operating systems that allows your computer to exchange information with other applications.  

 

 

You’ll need to make sure that Enable DDE Server is checked on the Server tab in the Options window. See 
Customizing Autotrading Settings in this section for more information. 

 

History Data cannot be exported through the DDE. Only current quotes can be exported. 

Managing Global Variables 
As you trade, you may have more than one expert advisor making and placing trades at one time. In order for these to 
work at times, the expert advisors need to exchange information through global variables. You can add and manage 
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global variables by clicking Tools in the menu bar and selecting Global Variables in the drop-down menu. This opens the 
Global Variables window.  

 

Click Add to add a variable. Double-click in each column to specify the variable name and its value. To remove a variable, 
select it and click Delete. 

Using the Advanced Security System 
MetaTrader uses 128-bit key encryption when trading. If you work with an organization that needs additional security, 
MetaTrader also offers an Advanced Security mode that provides public and private keys.  

If you are using the Advanced Security system, but need to place a trade at another computer, you will need to transfer 
the keys from your computer to the one you are trading on. The .key files are stored in the Config folder in the MetaTrader 
folder. 

 

If the Advanced Security system key has been lost or damaged, contact GFT Technical Support. 
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Appendix A: MetaTrader Hot Keys 
You can access tools and features in MetaTrader using the hot keys. These allow you to use the keys on your computer 
keyboard to open or close tools and features without navigating through menus or clicking in the toolbar.  

Keystroke Action 
Page Up  Scrolls the chart to the left. 
Page Down  Scrolls the chart to the right.  
Home Moves the chart to the oldest point in the chart history.  
End  Moves the chart to the most recent chart moves in the chart history.  
- Zooms out on the chart. 
+ Zooms in on the chart. 
Delete Deletes the selected drawing and technical objects from the chart. 
Backspace Deletes the last drawing or technical object created from the chart.  
Enter Opens or closes the Fast Navigation window in the chart.  
Esc Closes any windows.  
F1 Opens or closes the Online Help file. 
F2 Opens or closes the History Center window. 
F3 Opens or closes the Global Variables window. 
F4 Opens or closes the MetaEditor application.  
F8 Opens or closes the Chart Properties window. 
F9  Opens or closes the New Order window. 
F10 Opens or closes the Popup Prices window. 
F11 Opens or closes the chart window in full-screen mode.  
F12  Moves the chart by one bar to the left.  
SHIFT+F12 Moves the chart by one bar to the right. 
SHIFT+F5 Switches to the previous profile.  
ALT+1 Changes the chart type to bar chart.  
ALT+2  Changes the chart type to candlesticks chart.  
ALT+3 Changes the chart type to line chart.  
ALT+A Copies all test/optimization results to the Clipboard.  

ALT+W 
Opens the Windows list. If you have more than one chart window open, you can switch to 
a particular chart by selecting the chart you want and clicking Activate.  

ALT+F4 Closes MetaTrader. 
ALT+Backspace, 
CTRL+Z Undeletes the last deleted drawing or analytical object. 

CTRL+A Resizes the height of all indicator windows in a chart so that they're the same size. 

CTRL+B 
Opens the Objects List window. You need to have at least one object drawn in a specific 
chart window.  

CTRL+C, 
CTRL+Insert Copies the select drawing or analytical object to the chart.  
CTRL+D Opens or closes the Data window.  
CTRL+E Activates or deactivates the Expert Advisors button. 
CTRL+F Activates or deactivates the Crosshair cursor in the chart window. 
CTRL+G Activates or deactivates the grid in the chart window. 
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Keystroke Action 

CTRL+H 
Shows or hides the open, close, high or low prices in the upper-right corner of the chart 
window. 

CTRL+I 
Opens the Indicators List window. You need to have at least one indicator open in a 
specific chart window.  

CTRL+L Displays or hides the volumes in the chart window.  
CTRL+M Opens or closes the Market Watch window.  
CTRL+N Opens or closes the Navigator window. 
CTRL+O Opens the Setup window.  
CTRL+P Prints the current chart window.  
CTRL+R  Opens or closes the Strategy Tester window.  
CTRL+S Saves the chart as a .csv, .prn or .htm file.  
CTRL+T Opens or closes the Terminal window.  
CTRL+W,  
CTRL+F4 Closes the currently displayed chart window. 
CTRL+Y Displays or hides the period separators in the chart window.  
CTRL+F5 Switches to the next chart profile.  
CTRL+F6 Moves to the next chart window when more than one chart is open.  
CTRL+F9 Opens the Terminal window.  
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Finding Further Information 
We encourage you to learn more about how GFT can help you maximize your trading potential. Visit www.gftuk.com or 
call 0800 358 0864 or +44 (0) 20 7170 0770 to speak with a GFT specialist. You can also access Live Chat on our website 
to text chat with us as well. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

gftuk.com/ 0800 358 0864/ +44 (0) 20 7170 0770 

 

LIVE CHAT 24/7 TOLL FREE INTERNATIONAL 

IMPORTANT NOTE: When trading binaries, it is possible to lose more than your initial deposit. GFT Global Markets UK Ltd. 
is authorised and regulated by the Financial Services Authority. CD04UK.101.050611 
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